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ABBREVIATIONS 

AC – adenylyl cyclase 

CA – Cornu Ammonis  

CamK – calcium/calmodulin-dependent 

protein kinase  

cAMP – cyclic adenosine monophosphate 

CAv – voltage-gated calcium channel  

CF – climbing fibers 

CNO – clozapine-N-oxide 

CRE – cAMP response element 

CREB – CRE-binding protein  

Cx3cr1 – fractalkine receptor 

DA – dentate gyrus 

DAG – diacylglycerol  

DGC – dentate granule cell 

DMSO – dimethyl sulphoxide  

DREADD – designer receptor exclusively 

activated by designer drugs  

ER – endoplasmic reticulum 

GDP – guanosine diphosphate 

GIRK – G protein-gated inwardly rectifying 

potassium channels  

GTP – guanosine triphosphate  

Iba1 – ionized calcium-binding adapter 

molecule 1 

IP3 – inositol triphosphate 

MMP – matrix metalloproteinase  

Nav – voltage-gated sodium channel   

OHSC – organotypic hippocampal slice 

cultures  

PC – Purkinje cells 

PFA – paraformaldehyde  

PKA – protein kinase A  

PKC – protein kinase C 

PLC-β – β-isoform of phospholipase C 

PS – phosphatidylserine 

SIRPα – signal regulatory protein alpha  

SUB – subiculum 

Thy1 – thymocyte differentiation antigen 1 

TTX – tetrodotoxin 
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INTRODUCTION 

During early postnatal development neurons form more synaptic connections than it 

is maintained in the mature brain. The elimination of these excess synapses is an essential 

process for neural circuitry to mature (Park and Poo, 2013a). The primary effector of this 

process is microglia which exhibit increased phagocytic activity during the period of synaptic 

pruning (Weinhard et al., 2018). The activity of microglia is mostly determined by specific 

ligand-receptor interaction between microglia and their target (Li, 2012). However, emerging 

data suggest that neuronal activity might be the driving force behind the selection of which 

synapses are going to be removed (Leslie and Nedivi, 2011). Neuronal activity regulates 

pruning through competition-based mechanism. This results in less active synapses pruned 

while active ones strengthened (Rivest, 2018). However, mimicking the conditions where a 

subset of synapses is inhibited and others are relatively more active could simplify the 

experimental conditions and help to analyze how neuronal activity affect synaptic pruning.  

In this study we developed tools and strategies to investigate the role of neural 

activity in synaptic pruning. We established organotypic hippocampal slice cultures using 

Thy1::EGFP mouse line. It provided an experimental setting for the alteration of neuronal 

activity in vitro using DREADDs and morphological analysis of axonal boutons and dendritic 

spines. Thy1::EGFP, RC::LSL-tdTomato, Cx3cr1::Cre triple transgene mouse line was 

developed to analyze active interactions between neurons and microglia. Then, we optimized 

the conditions of AAV application  for the visualization of DREADD-expressing neurons and 

for the inhibition of their activity by using AAV8/2-CaMKIIα::hM4Di(Gi)-mCherry-WPRE-

hgHp(A) DREADD. Finally, we proposed a strategy for morphological analysis of axonal 

boutons and dendritic spines of neurons inhibited during peak synaptic pruning utilizing co-

localization of EGFP and mCherry signals.  
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AIM AND OBJECTIVES 

The aim of this study was to develop tools to investigate the role of neuronal activity in 

synaptic pruning. 

Objectives: 

1. To establish organotypic hippocampal slice cultures and to maintain slice viability for 

sufficient period to investigate synaptic pruning. 

2. To visualize neurons, microglia and their interactions utilizing organotypic cultures 

established using Thy1::EGFP, RC::LSL-tdTomato, Cx3cr1::Cre triple transgenic 

mouse line.  

3. To express AAV8/2-CaMKIIα::hM4Di(Gi)-mCherry-WPRE-hgHp(A) DREADD in 

a subset of pyramidal neurons and to visualize their axonal boutons and dendritic 

spines.   
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1. LITERATURE REVIEW 

1.1. Physiological significance of synaptic pruning 

The formation of established neuronal connections in the developing brain is 

considered to be crucial for the consciousness. Neural circuits are established by successive 

processes that include neuronal process growth, cell migration, target recognition and 

synaptogenesis (Low et al., 2008). During the early phase of neurogenesis, neurons tend to 

establish excessive connections. The role of excess primary connections is still to be 

explained; however, one theory states that it is caused by the limited presence of specific 

guidance cues (Tillo et al., 2012). Another hypothesis states that exuberant number of 

synapses encourages activity-dependent pruning and allows competition-driven refinement of 

developing circuitry (Rubenstein and Rakic, 2013). It has been shown that regressive activity 

is essential for neural circuit refinement pruning (Park and Poo, 2013b). Additionally, surplus 

connections could perform significant physiological and structural role during early 

development and especially during prenatal period (Riccomagno and Kolodkin, 2015). 

Developmental circuitry refinement includes synapse elimination, dendritic severing, axon 

and dendrite pruning. All of these mechanisms remove superfluous neuronal material, but 

preserve parental neuron with its typical signaling (Yu and Schuldiner, 2014). The pruning 

takes place in most parts of the nervous system, most notably, in the cortex, hippocampus, 

spinal cord and neuromuscular junction (Schuldiner and Yaron, 2015). 

In vertebrates, the removal of excess connections is largely restrained to postnatal 

development. Humans exhibit the elimination of connections in neural network for the first 

four to six years after birth and then cortical areas are additionally modified during puberty 

(Tierney and Nelson, 2009). The process is so intense that about 50% of previously emerged 

neurons are removed during postnatal growth (Cowan et al., 1984).  

The impairment in synaptic pruning was linked to a variety of pathological 

conditions including schizophrenia, autism spectrum disorders and Alzheimer’s disease. 

Notably, loss of synapses in the mature brain is an indicator for many neurodegenerative 

diseases (Presumey et al., 2017). More specifically, genome-wide association studies have 

showed a strong link between immune system specific (Trem2, CR1, CD33) and microglia 

specific (TYR-OBP) gene single-nucleotide polymorphisms and the late onset Alzheimer’s 

disease (Hong et al., 2016). Immune system specific markers also are important for 
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pathogenesis of schizophrenia and loss of grey matter (Mayilyan et al., 2008). Overall, 

increasing amount of research highlights the significance of synaptic pruning during the 

development. 

 

1.2. The role of microglia in synaptic pruning 

The molecular and cellular mechanisms involved in the remodeling neuronal 

network are have only be researched for the last few decades. The removal of excess synapses 

are mediated by microglia, astrocytes, Schwann cells and by neurons themselves through a 

processes that shares its molecular hallmarks with apoptosis (Eroglu and Barres, 2010). 

However, due to direct phagocytosis of synaptic terminals, microglia remain the principal 

cells responsible for neural network formation (Šišková and Tremblay, 2013). 

Microglia are a type of glial cells that descended from the myeloid hematopoietic 

lineage. Microglia colonize the developing CNS and takes a long-lasting residence in the 

brain (Kettenmann et al., 2011). In the pre-activation state, microglia have ramified 

morphology and can produce neurotrophic factors, for example, nerve growth factor (NGF), 

brain derived neurotrophic factor or insulin-like growth factor which induce neurogenesis 

(Bessis et al., 2007). They also continuously “scan” surrounding environment for signs of any 

disturbance and migrate to the location of infection or injury where they become activated, 

clear cellular debris and restructure surrounding cells. Activation of microglia is an intricate 

multistage process. The transformation from stable ramified to activated amoeboid 

morphology is achieved by retracting microglial processes and later extending dynamic 

protrusions for active cell locomotion (Davis et al., 2017). However, the functions of 

microglia go beyond their immunological duties. Microglia regulate synaptic homeostasis and 

the concentration of the neurotransmitters in the synaptic cleft highlighting its importance to 

neuron network function (Wake et al., 2012). 

The modification of neuronal network by glial cells has been observed in a number 

of model systems, ranging from peripheral synapses in the neuromuscular junction to central 

synapses in the cortex, hippocampus, thalamus and cerebellum. The increase of phagocytic 

activity during the postnatal development in these locations seems to support microglial role 

in synaptic pruning (Paolicelli et al., 2011). 

The action of microglia seems to be determined by specific ligand-receptor 

interactions. To simplify, these cues are classified as “eat-me” and “don’t eat me” signals (Li. 
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2012). ”Eat-me” signals enable synaptic material engulfment and/or promote phagocytic 

activity. Microglial phagocytic receptors are activated by direct interaction with neuronal 

molecules or through accessory proteins called opsonins (Fu et al., 2014). For example, 

phosphatidylserine (PS) (one of the essential phospholipid components of plasma membrane) 

can be recognized by multiple opsonins: milk fat globule EGF factor 8, growth arrest-specific 

protein 6 or protein S (Fricker et al., 2012; Grommes et al., 2008). Microglial activation by 

these molecules leads to the changes of cytoskeleton structure and increases phagocytic 

activity of microglia (Brown and Neher, 2014). On the contrary, transmembrane 

immunoglobulin superfamily protein CD47directly binds to the signal regulatory protein 

alpha (SIRPα) receptor located on professional phagocytes and inhibits phagocytosis 

(Okazawa et al., 2005). These examples show plethora of molecules and their interactions 

important for synaptic pruning.  

However, the interactions of specific molecules on the surface of neurons and 

microglia do not tell the full story. Emerging research hints that synaptic activity could be the 

driving force underlying the presentation of molecules on neuronal surface (Wu et al., 2015). 

For example, the density of displayed CD47 is higher on more active synapses, thus 

protecting synapses from microglia engulfment in retinal ganglion cells (Lehrman et al., 

2018). Also, fractalkine receptor (Cx3cr1) is important for the engulfment and phagocytosis 

of immature connections in the hippocampus. Reduced microglia engulfment and higher 

density of dendritic spines in hippocampus CA1 region has been observed in Cx3cr1 knock-

out animals (Paolicelli et al., 2011). Paolicelli and colleagues also reported that these 

excessive connections had immature connectivity with reduced frequency and amplitude of 

synaptic currents (Paolicelli et al., 2011). Overall, neuronal activity change interactions 

between neurons and microglia by regulating presented molecules. 

 

1.3. Neuronal activity during the maturation of neural circuits 

Neuronal activity is crucial during postnatal development when pruning of neuronal 

material is the most pronounced. The strengthening or weakening of individual synapses 

significantly regulate overall circuit organization and function (Leslie and Nedivi, 2011). 

Synaptic activity is important for the maturation of neural circuits both at the level of single 

synapse and on that of systemic network. Activity-dependent changes regulate calcium 
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sensitive proteins which in turn activate different molecular pathways important for synaptic 

maturation (Fig. 1.1).  

 

Figure 1.1. Presynaptic neural activity induces SIRPα shedding and interaction with CD47 

receptor providing a feedback loop for presynaptic maturation. CamK – Calmodulin kinase. 

SIRPα – signal regulatory protein alpha (Toth et al., 2013). 

 

Synaptic activity upregulates calcium/calmodulin-dependent protein kinase (CamK) 

which in turn upregulates matrix metalloproteinase (MMP). MMP mediates the cleavage of 

the ectodomain of SIRPα and then SIRPα is able to bind CD47 receptor on the presynaptic 

compartment (Toth et al., 2013). SIRPα−/− mice showed decreased neurotransmitter release, 

diminished LTP and lower impaired basal transmission (Toth et al., 2013). These findings 

revealed the significance of neural activity for synaptic maturation at an individual synapse. 

Neural activity also has a wider effect on the structure of developing neural 

networks. For example, activity-dependent synaptic refinement shapes the development of the 

climbing fibers (CF) in the cerebellum (Hashimoto and Kano, 2013). CFs derive from the 

inferior olive and continue to Purkinje cells (PC) in the cerebellum. During the prenatal 

development, every PC is innervated by multiple CFs of comparable strength. However, 

following the first few weeks after birth, CF go through large-scale axon pruning and 

synapses formed by the CFs with lower activity are successively eliminated (Watanabe and 

Kano, 2011). In mature human cerebellum, a winning CF with a particularly high activity 

secures its entire dendritic tree with a myriad of synapses on the proximal dendrite of the PC. 

Strong CF easily depolarizes the PC it connects to and triggers the influx of Ca2+ ions, thus 
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ensuring swift and precise signal transmission (Hashimoto et al., 2009a). Neural activity is the 

prime cause of the CF network sculpting, as demonstrated by the administration of ion 

channel blockers. For example, CF, inhibited by AMPA receptor blockers, were more actively 

eliminated. Reduced number of CF remained even in adult rodents (Hashimoto et al., 2011). 

Moreover, when ordinary activity pattern is changed during early postnatal development by 

using pharmacological agents or by the overexpression of chloride channel proteins,  

numerous CFs remain innervating individual PCs (Lorenzetto et al., 2009). Similarly, the 

deletion of calcium voltage-gated channel subunit alpha 1 (CAv2.1) results in the disruption 

of CF synapse removal in the primary pruning phase (Hashimoto et al., 2011). Another factor 

affecting elimination of the CF is the location of the connection. Weaker synapses tend to 

attach on the soma and are subsequently pruned while stronger connections are more likely to 

be added on the dendritic tree of PCs. Meanwhile, more powerful dendritic synapses are 

strengthened even more and weaker somatic connections are removed  (Hashimoto et al., 

2009b). 

Other researchers (Markwardt et al., 2009; Piatti et al., 2011) point to the relevance 

of inhibition and GABA signaling. This is further supported by the fact that hippocampal 

progenitor cells establish GABAergic connections before excitatory glutamatergic synapses 

are formed (Wadiche et al., 2005). Furthermore, during neurogenesis new dentate granule 

cells (DGCs) display high excitability, and a lower threshold to start long term potentiation. 

Therefore, immature DGCs are process information in early stages of development (Espósito 

et al., 2005; Wadiche et al., 2005). On the contrary, during later part of maturation, when 

functional connectivity increases, the excitability of DGCs decreases. (Laplagne et al., 2007). 

These findings show that the development of hippocampal synaptic network is regulated by 

both excitatory and inhibitory activity. 

 

1.4. Methods for the visualization of neuronal activity 

The activity of neurons is important for the maturation of the entire neural network. 

Hence, it is crucial to identify the activity levels of individual synapses. This would allow to 

investigate whether less active synapses are more preferentially approached by microglia to 

potentially be removed or modified. Thus, methods designed to visualize the activity of 

neurons and synapses are in high demand. 
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Calcium imaging allows to directly measure the activity of both subcellular 

compartments of individual neuron and the populations of neurons. Calcium is required for 

the exocytosis of synaptic vesicles in the presynaptic terminal (Neher and Sakaba, 2008). 

Also, calcium spikes regulate the initiation of activity-dependent synaptic plasticity in the 

postsynaptic terminal (Zucker, 1999). The earliest calcium indicators were bioluminescent 

calcium-binding photoproteins, such as aequorin (Shimomura, Johnson, and Saiga 1962). 

These calcium sensors provided early understanding of activity-dependent neuronal 

regulation. However, these indicators had poor sensitivity and difficult implementation 

(Llinas and Nicholson, 1975). Novel calcium indicators have been constructed by fusing 

calcium-selective chelators with a fluorescent marker. They provide a wide sensitivity range 

and can to be used in a wide concentration range from 50 nM to 50 μM (Oliver et al., 2000). 

The variety of calcium indicators (fura-2, indo-1, fluo-3, fluo-4 quin-2, Oregon Green 

BAPTA, X-rod-1) allows the choice of a wide range of excitation wavelengths (315nm – 615 

nm) (Paredes et al., 2008). Furthermore, calcium indicators are divided into single wavelength 

and ratiometric. Single wavelength calcium indicators display significant changes in 

fluorescence intensity after binding Ca2+ without any changes in the excitation or emission 

wavelengths (Nicotera and Rossi, 1994). On the other hand, ratiometric calcium indicators 

exhibit the change in excitation or emission spectra after binding Ca2+ (Thestrup et al., 2014). 

This provides a greater accuracy and avoids any drawbacks of single wavelength indicators 

such as, the leakage of dye, the changes in cell volume, photobleaching and uneven dye 

loading (Paredes et al., 2008). High variety of calcium indicators provides accurate and 

sensitive tool for investigation of neuronal activity. 

Another widely used tool for the analysis of neuronal activity is FM dyes. FM dyes 

(named after their creator Fei Mao) specifically label synaptic vesicles in live samples (Betz 

and Bewick, 1992). Their unique characteristics are defined by the structural features of the 

molecule. The tail region of the FM molecule interacts with lipids or other hydrophilic 

domains. The central region contains two aromatic rings connected by a bridge which form a 

fluorophore. Finally, the head group has a positive charge and helps the dye to stay inside the 

vesicle (Gaffield and Betz, 2007). The dye can only leave the synaptic vesicles by exocytosis. 

Once exocytosed, they quickly diffuse into extracellular space and lose their fluorescence 

(Richards et al., 2005). FM dyes are non-toxic, stable and dye-loaded vesicles can be released 

by artificial stimulation of presynaptic terminals (Richards et al., 2000). The main 

disadvantage of FM dyes is their broad emission spectra. When used with another fluorescent 

dye this might cause the bleed-through into other emission channels (Gaffield and Betz, 
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2007). Also, it was reported that FM dyes shifts emission spectrum based on the environment 

they enter into (Johnson and Betz, 2008). Despite these drawbacks, FM dyes remain one of 

the most convenient methods for the staining of synaptic vesicles and the only method that 

displays the capability to visualize the unloading of synaptic vesicles (Kraszewski et al., 

1995). 

 

1.5. Methods for the modification of neuronal activity 

Changing neuronal activity of could mimic the conditions during synaptic maturation 

when neurons of different activity compete for incoming connections (Cancedda and Poo, 

2008). One of the oldest and well understood tools for the alteration of neural activity are 

pharmacological agents. Pharmacologically-induced inhibition of neuronal activity has been 

studied for decades utilizing selective voltage-gated sodium channel (Nav) blocker 

tetrodotoxin (TTX) (Sci and 1939). TTX is synthesized by bacteria most commonly located in 

puffer fish (Miyazawa et al., 1987). The inhibition strength of TTX differs on different 

subtypes of sodium channels with the most effective inhibition on Nav 1.1, 1.2, 1.3, 1.6, 1.7 

subtypes (Wakita et al., 2015). Also, the location of voltage-gated sodium channels is 

important for the kinetics of the inhibition. Presynaptic Nav have faster inactivation kinetics 

compared to the somatic channels. Besides, presynaptic terminals have high density of these 

Nav further facilitating the inhibition of synaptic currents (Engel and Jonas, 2005). All of 

these properties made TTX one of the most widely used drugs for the inhibition of neuronal 

activity. However, pharmacological agents are poorly suited for targeted inhibition of 

neuronal activity since it inhibits all neurons expressing Nav channels. 

On the other hand, optogenetics is a modern technique that allows to control neural 

activity with high temporal and spatial precision (Lyon, 2013). Optogenetics utilize light-

sensitive proteins opsins (transmembrane proteins) that are genetically engineered to be 

expressed in neurons of interest. Opsins work as light-sensitive ion channels (Boyden et al., 

2005). Neurons can be engineered to express opsins by using viral vectors, transgenic knock-

in animals or Cre-recombinase based mouse lines. All of these systems enable the expression 

of an optogenetic construct in a specific neuronal population (Yi Liu et al., 2018). The activity 

of opsin-expressing neurons can be modified by the illumination with light of specific 

wavelength. Opsins can induce single or multiple action potentials. The frequency and the 

pattern of these spikes can be regulated by the wavelength of the opsin-activated light.  



 

  14 

Opsins are categorized into two major groups. Type I opsins are found in microbial 

organisms and consist of a single membrane-bound protein (Oesterhelt and Stoeckenius, 

1973). These proteins work as a pump or as an ion channel. Type I opsins remain used mainly 

due to the ease of genetic engineering and their fast kinetics (Nagel et al., 2003). Type II 

opsins are found in animal cells and are G protein–coupled receptors. After the activation, 

they initiate a signaling cascade and subsequently generate slow changes in neural activity 

(Guru et al., 2015). Both types can effectively alter neuronal activity. However, optogenetic 

alteration of neuronal activity suffers from multiple disadvantages. Most notably, optogenetic 

tools synchronize the activity of all targeted neurons. Such synchronization is not 

physiological as any individual firing patterns are lost (Yizhar et al., 2011). Also, optogenetic 

inhibitors can force neurons into supra-physiological hyperpolarization, which can result in 

rebound excitation after the end of inhibition (Kravitz and Bonci, 2013). Finally, non-specific 

integration of opsins in the cell membrane can cause antidromic activation of neuronal bodies 

and collaterals (Tye et al., 2011). Overall, optogenetic technique is a useful tool to alter 

neuronal activity. However, it has number of experimental limitations. 

The most recent and very promising technique for the alteration of neuronal activity 

is designer receptors exclusively activated by designer drugs (DREADD). DREADD-based 

chemogenetic tools provide the opportunity to both analyze neuron – microglia interactions 

and to mimic the conditions during the formation of CNS when some synapses are 

strengthened and others are weakened (Roth 2016). DREADDs circumvent a lot of limitations 

of optogenetic techniques without the need of the light source for the change in neuronal 

activity (Vlasov et al., 2018).  

DREADDs were developed by the means of directed molecular evolution in 

genetically engineered yeast by applying small pharmacologically inert molecules to activate 

G protein-coupled receptors. Originally, human M3 muscarinic receptor was subjected to 

many trials of selection and mutagenesis. After extensive bioinformatic and pharmacological 

characterization M3 muscarinic receptor with two pivotal mutations (Y149C, A239G) was 

selected (Sternson and Roth, 2014). This receptor called hM3Dq is activated by synthetic 

ligand clozapine-n-oxide (CNO), has relative insensitivity to the native ligand acetylcholine, 

is absent of any detectable spontaneous activity. Since, previously mentioned mutations are 

highly conserved in muscarinic receptors in most species, researchers created a plethora of 

DREADDs (hM1Dq, hM2Di, hM3Dq, hM4Di, hM5Dq) with the variety of molecular effects 

(Urban and Roth, 2015). 
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Since DREADDs are the descendants of native GPCRs, they contribute to the same 

cellular regulatory processes. For example, their activity might be modulated by 

phosphorylation, internalization, desensitization and other structure-altering molecular 

modifications (Rajagopal and Shenoy, 2018). Similarly, their mechanism of action is identical 

to that of the original GPCR. For instance, activating Dq (equivalent to Gq) group (Fig. 1.2 A, 

B), induces the release of guanosine diphosphate (GDP) and the binding of guanosine 

triphosphate (GTP) (catalyzed by the guanine nucleotide exchange factor) on G protein α 

subunit which separates Gαβγ complex into Gαq and Gβγ parts (Trzaskowski et al., 2012). 

Both segments stimulate β-isoform of phospholipase C (PLC-β), which catalyzes the 

hydrolysis of phosphatidylinositol biphosphate (Alexander et al., 2009a). The products of this 

reaction are inositol triphosphate (IP3) and diacylglycerol (DAG). IP3 travels through the 

cytoplasm and binds to specific receptors in the membrane of endoplasmic reticulum (ER). 

Receptor-ligand interaction opens tetrameric ER Ca2+ channels and increases intracellular 

Ca2+ concentration, which modulates other ion channel kinetics and the function of the 

enzymes. DAG increases the probability for protein kinase C (PKC) to be transported to the 

cell membrane, which is required to activate it (Gurevich and Gurevich, 2017; Tuteja, 2009). 

Slightly different molecular pathway applies to the inhibitory group Di (equivalent to Gi) 

(Fig. 1.2 A, B). In this case, receptor activation Gα is dissociated, but the detached subunit 

acts through adenylyl cyclase (AC) dependent pathway (Montminy et al., 1990). First, Gα 

binds to the inhibitory domain of adenylate cyclase and suppress its activity, thus decreasing 

the generation of cyclic adenosine monophosphate (cAMP) from ATP. Reduced amount of 

cAMP lower transcription of distinct genes encompassing regulatory cAMP response element 

(CRE) (van Keulen and Rothlisberger, 2017). In addition, the reduction of cAMP weakens the 

activity of many phosphorylating kinases, in particular protein kinase A (PKA). Reduced 

cAMP levels slow down PKA activation and change of conformation to phosphorylate CRE-

binding protein (CREB) (Sassone-Corsi, 2012; Yan et al., 2016). Unphosphorylated CREB 

can’t form cAMP-responsive transcription complex, which regulates genes responsible for 

cell survival, differentiation and survival. The Gβγ complex, disconnected by Gi, activates 

other inhibitory downstream effectors, especially, G protein-gated inwardly rectifying 

potassium channels (GIRK). Opening of GIRKs increase concentration of intracellular 

potassium and hyperpolarize the cell. Finally, activity of GPCRs  end when intrinsic GTPase 

activity of Gα hydrolyze GTP to GDP and Gα-GDP rejoins Gβγ to form Gαβγ (Cooper, 

2000). 
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Figure 1.2. The development of DREADDs and their intracellular signaling cascades. A – 

Muscarinic receptors were evolved to DREADDs that are activated by CNO; B – Molecular 

pathways involved in the activity of hM3Dq and hM4Di. Adapted from Michaelides and 

Hurd, 2015 (Michaelides and Hurd, 2015). CNO – clozapine-N-oxide; Gq,Gi,Gs – types of G 

protein-coupled receptors; IP3 – inositol triphosphate; PIP2 – phosphatidylinositol 4,5-

bisphosphate; PLC – phospholipase C; DAG – diacylglycerol; AC – adenylyl cyclase; PKA – 

protein kinase A; cAMP - cyclic adenosine monophosphate; GIRK – G protein-coupled 

inwardly-rectifying potassium channels. 

 

Different DREADDs utilize different regulatory processes to specifically affect 

neuronal activity. Activating receptor hM3Dq depolarize the cell increase firing frequency in 

various neuronal populations throughout central nervous system, including the neurons of 

raphe, arcuate nuclei and hippocampal CA1 excitatory pyramidal neurons (Atasoy and 

Sternson, 2018). Activation of hM3Dq in in vivo studies show changes in social behavior, 

feeding, energy expenditure, locomotion and memory (Roth, 2016). On the other hand, 

inhibiting receptor hM4Di decreases neuron firing, causes modest hyperpolarization and can 

cause complete neuron silencing. (Agulhon et al., 2013; Scofield et al., 2015). Silencing of 

neurons is achieved not only by the hyperpolarization by GIRKs but mainly by the inhibition 

of neurotransmitter release from the presynaptic compartment (Zhu and Roth, 2014).  

DREADDs are not affected by neuromediators and are activated by 

pharmacologically inert drugs. For example, the compound most often used for DREADD 

activation is CNO which has no native receptors in mice and rats that have not received 

DREADD treatment (Armbruster et al., 2007). CNO is affected by reverse transformation to 
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pharmacologically active clozapine that can affect behavior of humans, primates and guinea 

pigs (Jann et al., 1994). Researchers employ a wide range of doses from 0,5 µM to 200 µM 

with noticeable electrophysiological effects in acute slices (Pati et al., 2019). Other notable 

DREADD activating drugs are N-desmethyl-clozapine, salvinorin b, compound 21 and 

perlapine (Roth, 2016). These chemicals have less pharmacological data and further studies 

are needed to establish their suitability for DREADD activation. 

The expression of DREADDs in a specific population of neurons is ensured using the 

same methods as in optogenetics. Most widely used targeting system remains viral vectors 

that ensure good spatial control of expression with relatively low costs (Campbell and 

Marchant, 2018). Other notable expression systems are tetracycline regulated promoters and 

Cre-mediated recombination. Using these methods, hM3Dq and hM4Di maintain life-long 

high levels of expression without any basal behavioral, electrophysiological or anatomical 

anomalies. (Alexander et al., 2009b; Zhu et al., 2014).  

Overall, DREADDs are considered an effective and convenient tool for the alteration 

of neuronal activity. They are utilized to change the activity of neurons in many different 

neuronal populations, including the hippocampus (Tuscher et al., 2018). However, further 

studies are required to develop optimal conditions for DREADD expression and visualization 

in neurons. 
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2. MATERIALS AND METHODS 

2.1. Materials 

The following tables list and specify materials, equipment and software used in this 

study. 

2.1.1. Chemical reagents 

Reagents Manufacturer 

AAV8/2-CaMKIIα::Hm4Di(Gi)-mCherry-WPRE-hgHp(A) Neuroscience Center Zurich 

Acetone Roth 

BME (1X) Gibco 

Clozapine N-Oxide (CNO) Tocris 

Clozapine-N-oxide Tocris 

DAPI (4’,6-Diamidino-2-Phenylindole, Dihydrochloride) Sigma-Aldrich 

Dimethyl sulphoxide (DMSO) Roth 

Glucose Sigma-Aldrich 

GlutaMAX (100X) Gibco 

Glycine Sigma-Aldrich 

HBSS Gibco 

HEPES  Gibco 

Horse Serum Gibco 

MEM (10X) Gibco 

Mowiol Calbiochem 

Normal Donkey Serum  Abcam 

Normal Goat Serum  Abcam 

Paraformaldehyde (PFA) Sigma-Aldrich 

PBS tablets pH 7.4 Sigma-Aldrich 

Penicillin/streptomycin (100X) Gibco 

Sodium azide Merck Group 

Sodium bicarbonate (NaHCO3) Roth 

Sodium Chloride (NaCl) Roth 
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Sodium Hydroxide (NaOH) Roth 

TRIS-HCl  Roth 

Triton X-100 Merck 

2.1.2. Media, buffers and solutions 

Name Composition 

Dissection medium Penicillin/streptomycin (100X) 1 %, HEPES 15 mM, glucose 

0.5 % in HBSS filtered after. 

Maintaining medium BME (1X) 25 %, horse serum 25 %, MEM (10X) 5 %, 

penicillin/streptomycin (100X) 1 %, GlutaMAX 2 mM, 

glucose 0.65 %, sodium bicarbonate 9 mM in ddH20 and 

filtered after. 

PB 0.4 M 16.1 g/l KH2PO4, 56.8 g/l Na2HPO4 in ddH20. 

PFA 4%  PFA 4%, 0.1 M PB, 50ml ddH2O. 

PFA 8% 8 g PFA added drop wise NaOH (stock 1 M) to dissolve, 

adjusted to 100 ml with ddH2O, drop wise HCL adjusted pH 

to 7,2 – 7,4. 

Triton-X/PBS  0,5 % of Triton-X slowly added into PBS while mixing.  

Clozapine-N-oxide  CNO 20 mM in DMSO 

2.1.3. Mouse lines 

Genotype Description Reference 

Thy1::EGFP Thy1:EGFP mouse line has Thy1 promoter region 

required for neuronal expression of EGFP in excitatory 

pyramidal neurons in the hippocampus 

JAX No 

003709 

Thy1::EGFP 

Cx3cr1::Cre 

RC::LSL-tdTomato 

Triple transgene mouse line with EGFP labeled 

excitatory pyramidal neurons in the hippocampus and 

tdTomato labeled microglia. Density of the labeling is 

controlled by estrogen receptor agonist tamoxifen.  

Expression of Cre recombinase is under control of 

fractaline promoter Cx3Cr1. When Cx3cr1::Cre mice are 

bred with mice containing floxed sequence its offsprings 

will have the floxed sequence removed. 

JAX No 

003709 

006148  

007905 



 

  20 

This mice line contains Rosa-CAG-LSL-tdTomato-

WPRE conditional allele. When bred with mouse 

containing Cre recombinase, emerging pups will have 

STOP fragment removed in Cre expressed tissues and 

will start expressing tdTomato. 

2.1.4. Consumables 

Name Manufacturer 

Double-sided stainless-steel blades Personna 

6-well cell culture plates Costar 

24-well cell culture plates Costar 

Coverslips (24x60mm)  Roth 

Dick Blick Wonder White brush Dick Blick 

Sharp surgical forceps ThermoScientific 

Bent surgical forceps ThermoScientific 

Narrow end surgical scissors  ThermoScientific 

Microscope slides (76x26mm) Roth 

Multi®SafeSeal® Tubes, 1.7ml, natural Roth 

2.1.5. Equipment 

Name Manufacturer 

McILWAIN Tissue Chopper The Mickle Laboratory Engineering 

Co.LTD 

Leica EZ4 stereoscopic microscope Leica 

Microprocessor pH Meter Hanna Instruments 

Horizontal shaker ThermoScientific 

Peristaltic pump ThermoScientific 

EVOS FL Auto Live Cell Imaging System ThermoScientific 

Leica TCS SP5 Confocal microscope Leica 
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2.1.6. Software 

Name Manufacturer 

Microsoft office Microsoft Inc. 

LAS AF Leica 

ImageJ version 1.52p NIH Image 

GraphPad Prism6 GraphPad Software 

 

2.1.7. Antibodies 

Name Manufacturer 

Polyclonal rabbit Anti-RFP (N° 600-401-379) Rockland 

Polyclonal goat Alexa Fluor 568 (N° A11011) Invitrogen 

 

2.2. Methods 

2.2.1. Organotypic hippocampus slice culture 

Organotypic hippocampal slice cultures (OHSC) were prepared using three day old 

mouse pups. Before dissection, number of preparations were done. First, cell culture 

membranes were placed in the 6-well plates using sterile forceps. Specific OHSC maintaining 

medium (preparation described in chapter 2.1.2.) was added to the plates and plates were 

placed in 35 °C 5% CO2 incubator. Dissection was performed with 4 pairs of sharp forceps, 

dissection spatula, a pair of curved tweezers, scalpel, sharp dissection scissors and a Dick 

Blick Wonder White brush. All metal tools were sterilized using autoclave at 121 °C and 311 

kPa for 40 min. Before the experiment, the brush was kept in 70 % ethanol for 5 min, air dried 

and kept in HBSS during the procedure. 150 mm petri dish was filled with ice to get a cool 

working surface. Isolated brain and hippocampi were always kept in ice cold dissection 

medium (preparation described in chapter 2.1.2.). Hippocampi were sliced with McIlwain 

tissue chopper. Before using the chopper, its blade was washed for 5 min in acetone followed 

by 2 min in 99% ethanol and finished by 2 min in 70% ethanol.  

Procedure started with cervical dislocation, followed by decapitation. Then, head was 

placed into a 60 mm Petri plate, sprayed with ethanol and moved into the flow cabinet for all 

following procedures. Before continuing the preparation, gloves were changed which ensured 
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sterility. Petri dish with mouse head was placed on ice and dissection was started by inserting 

one pair of sharp forceps into the eye sockets of the pup to achieve stable fixation of the head. 

Another pair was used to remove skin and skull (which at this point is only a thin layer of 

cartilage). The skull was removed by a gentle low angle puncture of the skull at the midline 

and then turning horizontally towards periphery. After exposing the brain, it was extracted by 

gently placing dissection spatula at the bottom of skull cavity. Isolated brain was placed in a 

new 60 mm Petri dish filled with ice cold dissection medium. Next, brain was placed on the 

ventral surface and from the superior view incisions were made between the hemispheres and 

in the space of transverse sinus just above the superior colliculus. Cuts were made in a bent 

coronal manner to reduce the amount of midbrain tissue covering hippocampus. Cut 

hemispheres were placed on a ventral surface. Hippocampal site was located on the medial 

side of the hemisphere. 

Next, meninges and blood vessels were removed using bent sharp forceps. After that, 

hippocampus was rolled out using curved forceps and entorhinal cortex was nipped of. After 

both hippocampi were removed, they were moved onto the platform of the McIlwain tissue 

chopper. The tissue was sliced into 300 μm slices using 50 strokes/min slicing speed and 

setting “1” for blade force. Slices were delicately collected from the cutting surface using the 

brush and moved back to the dissection medium. Then, slices were examined for any signs of 

damage. Cuts with damage to CA1, CA3 or dentate gyrus were immediately rejected. Intact 

slices were carefully planted on previously prepared cell culture inserts with maintaining 

medium in a 6-well plate. One cell culture insert was sufficient to place 6 – 8 slices. Medium 

was changed 24 h after the planting and every 2-3 days during culture maintenance. OHSC 

were maintained in an incubator at 35 °C with 5% CO2.  

 

2.2.2. Fixation, staining and mounting of organotypic slices 

Before fixation 4% PFA 0,1 M PB solution was made (preparation described in 

chapter 2.1.2.). Fixation was performed in the fume hood to avoid the exposure to PFA. 3 ml 

of 4% PFA was added to each well with cell culture inserts (2 ml on the bottom of the well 

and 1 ml into the insert itself) to submerge the slice and incubated in the RT for 30 min. 

During this step it was crucial to keep the plate still because any movement can disrupt tissue 

polymerization caused by the PFA. Next, slices were washed once with PBS followed by a 2-

time wash with 30 mM Glycine/PBS for 15 min (3 ml into all wells). Finally, slices were 
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washed twice with PBS for 15 min. Every step of the washing was performed using a 

horizontal shaker. After fixing, cell culture inserts were placed on a dark surface to carefully 

cut out individual slices and placed in individual wells into a 24-well plate. Samples were 

kept in PBS/Sodium azide solution at 4 °C until further staining. 

Slices were stained with DAPI fluorescent staining to visualize the structure and 

distribution of cells within the slices. DAPI has high affinity to adenine – thymine rich 

regions of the DNA and is widely used for nuclear staining (Jang et al., 2018). Each slice was 

treated with 0,5 ml of 0,1% DAPI and incubated for 15 min at RT on the horizontal shaker. 

From now on, slices had to be protected from light to maintain fluorescent signal. After 

incubation, samples were washed 3 times for 15 min using PBS on horizontal shaker. Slices 

were kept in PBS/Sodium azide solution at 4 °C, in the dark until further notice. 

Immunofluorescent staining was performed utilizing the following protocol: 

1. Blocking and permeabilization:  

Slices were placed into a 24-well cell culture plate (up to 4 slices per well). 500 μl of 

permeabilization buffer, consisting of 400 μl 0,5% Triton-X/PBS (preparation described in 

chapter 2.1.2.) and 100 μl of normal goat serum was pipetted in to the well. Slices were 

incubated in the buffer for 16 h on a shaker at 4 °C. 

2. Incubation with primary antibodies: 

After the permeabilization, slices were incubated in 250 μl of primary antibody 

solution for 24 h on a shaker at 4 °C. Primary antibody solution consisted of 185 μl PBS, 50 

μl 0,5% Triton-X/PBS, 12,5 μl normal goat serum and 2,5 μl primary rabbit polyclonal anti-

RFP antibodies (dilution 1:100). After the incubation slices were washed three times using 1 

ml of PBS per well for 15 min each wash. 

3. Incubation with secondary antibodies: 

Next, slices were incubated in 250 μl of secondary antibody solution for 4h at RT. 

Solution consisted of 237 μl PBS, 12,5 μl normal goat serum, 0,625 μl secondary goat 

polyclonal Alexa Fluor 568 antibodies (dilution 1:400). After incubation slices were washed 

three times using 1ml of PBS per well for 15min each wash. 

Slices were mounted onto the microscope slides for confocal microscopy. First, 

MOWIOL solution was prepared using procedure described in chapter 2.1.2. Slices were 

placed on the microscope slides and were left to air dry (drying is over when membrane that 

slice resides on turns completely white). 5 μl drop of MOWIOL was applied on the dried slice 

using a 200 μl pipette tip (it was important to prevent the formation of bubbles). One 

microscope slide usually supported up to 8 samples. Dried slices covered with MOWIOL 
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were covered with a coverslip and left to dry for 24 h in the dark at RT. Later, samples were 

stored at 4 °C. 

 

2.2.3. OHSC treatment with AAV-hM4D construct and DREADD 

activation by CNO 

OHSC were treated with AAV8/2-CaMKIIα::Hm4Di(Gi)-mCherry-WPRE-hgHp(A) 

construct to establish experimental conditions in which neuron activity could have been 

inhibited. DREADD was administered at various time points (DIV 1, 5, 7, 12). Different 

concentrations (9 x 108 vg, 3,6 x 108 vg, 1,8 x108 vg) were tested. 1 μl of AAV-hM4D was 

applied on top of each slice. Medium was changed 2 days after infection. Later medium was 

changed as usual, every 2-3 days. 

After hM4D DREADD expression CNO was administered to OHSC to inhibit 

hM4D-mCherry expressing neuron activity. CNO was mixed with pre-warmed maintaining 

medium to obtain 10 μM CNO concentration. 1.2 ml of this mixture was added under 

culturing membrane and additional 10 μl drop was added on top of each OHSC. Medium was 

changed to the maintaining medium after 24 h.  

 

2.2.4. Imaging of OHSC using EVOS live imaging system 

EVOS® FL Cell Imaging System was used to monitor Thy1 mediated EGFP 

expression in pyramidal neurons, OHSC viability, neuronal network development and AAV-

hM4D fluorescence in organotypic slices. EGFP signal labelled excitatory pyramidal 

hippocampal neurons and mCherry signal allowed to detect hM4D-mCherry-expressing 

neurons. 

EVOS® FL Cell Imaging System utilizes light-emitting diode to provide multi-

channel fluorescence imaging. For all acquired images 10× magnification objective was used. 

Visualization of EGFP-expressing excitatory pyramidal neurons was obtained using light 

cube providing excitation at 459 – 481 nm wavelenghts at following parameters: light 

intensity – 45, exposition – 137 ms, gain – 1.6. For EGFP signal 500 – 550 nm wavelenght 

emision was registered. hM4D-mCherry expressing neurons were imaged using light cube 

providing excitation at 570 – 599 nm wavelght range using following parameters: light 
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intensity – 45, exposition – 1100 ms, gain – 7. For mCherry signal 612 – 644 nm wavelenght 

emision was registered. Base settings for all imaging were set to: brightness – 63, contrast – 

58. Different imaging parameters were used to acquire high-detail images of both EGFP and 

mCherry fluorescence signals and to accomodate for the fact that quantum yield and 

fluorescence intensity of mCherry are much lover compared to EGFP (Shaner et al., 2005).  

 

2.2.5. Imaging of OHSC using confocal fluorescent microscopy 

Confocal imaging was performed on the Leica TCS SP5 confocal microscope with 

63×/1.4 oil immersion objective. DAPI staining was visualized using 405 nm diode laser at 

20% power. Emission was registered at 415 nm – 460 nm wavelengths. DAPI stained nuclei 

were imaged using 1.7× optical zoom (pixel size 141×141 nm2). 

EGFP-expressing neuron images were acquired using argon diode laser with 488 nm 

excitation wavelength at 20% power. Emission was registered at 500 – 550 nm wavelengths. 

Neuron soma was imaged with 1.7× optical zoom (pixel size 141×141 nm2) while axonal 

boutons and dendritic spines were imaged using 5× optical zoom (pixel size 46×46 nm2) with 

z-axial step size 118 nm.  

hM4D-mCherry-expressing neurons were imaged using diode pumped solid state 

(DPSS) laser with 561 nm excitation wavelength. Emission was registered at 570 – 630 nm 

wavelengths. Neuron soma was imaged with 1.7× optical zoom (pixel size 141×141 nm2) 

while dendrites with 5× (pixel size 46×46 nm2) and z-axial step size 118 nm. 

tdTomato-expressing microglia were imaged using DPSS laser with 561 nm 

excitation wavelength. Emission was registered at 570 – 650 nm wavelengths. Microglia was 

imaged with 1.7× optical zoom (pixel size 141×141 nm2) and z-axial step size 118 nm. 

 

2.2.6. Image analysis 

Analysis of images was performed using ImageJ version1.52p software. 
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2.2.6.1. Analysis of images acquired on EVOS live imaging system 

Background from images with mCherry signal was subtracted using 

Process>Subtract background>Set rolling ball radius to 50 pixels. mCherry signal grey values 

were represented from 0 to 40 using Brightness and contrast>Set>Min:0, Max:40 (8 bit 

format images). 

 

2.2.6.2. Protocol for counting tdTomato-expressing microglia  

tdTomato-expressing microglia were counted using the following protocol: 

1. Image background was subtracted to reduce background noise and to ensure better 

segmentation of individual cells (Fig. 2.1.) using Process>Subtract background>Set 

rolling ball radius to 50 pixels. 

 

Figure 2.1. The effect of background subtraction. OHSC images before (1) and after (2) 

background subtraction. A – without tamoxifen and B – treated with tamoxifen. 

 

2. Individual microglia were counted (Fig. 2.2.) using Process>Find Maxima>Set 

prominence to 30. Prominence was selected to obtain individual selection of microglia 

cells. Edge maxima were excluded to count only fully visible cells. 
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Figure 2.2. Marked individual microglia. A – without tamoxifen. B – treated with tamoxifen. 

 

2.2.6.3. Quantitative analysis of hM4D-mCherry fluorescence 

Measurements were performed using the following protocol:  

1. To observe weak signal grey values were displayed from 0 to 20 using Brightness and 

contrast>Set>Min:0, Max:20. 

2. To align of major regions of the hippocampus in all the slices (Fig. 2.3.) images were 

flipped using Image>Transform>Flip Vertically/Horizontally. Next, smaller adjustments 

were made with Image>Transform>Rotate to achieve optimal alignment. 
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Figure 2.3. OHSC alignment procedure. 1. A and B images before alignment. 2. A and B 

images after alignment. 

 

 

3. To measure the exact area ROI was created. The process of creating ROI used in 

measurements was described in chapter 3.3.2. ROI was applied and aligned to 

hippocampal regions. 

4. ROI was added to the ROI manager using Analyze>Tools>ROI Manager>Add. 

5. Entire picture was selected by using Edit>Selection>Select all and added to the ROI 

manager. 

6. In the ROI manager, ROI of interest and the entire picture was selected and XOR 

function was used to only select the background. 

7. Background was removed using Selection>Select None. 

8. Threshold was set to 13-255. Threshold was set by Image>Adjust>Threshold. 

9. Set required measurements. We used: 

a. Area – to measure area of selection signal in square pixels. 

b. Mean gray value – average signal value in the selection. 

c. Integrated density – the sum of pixel values of the signal in the selection. 

Measurements were limited to the threshold. 
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10. ROI (preparation described in 3.3.2) was added back to the image. 

11. Measurements were made using Analyze>Measure. 

 

2.2.6.4. Processing of images acquired with confocal fluorescent microscope 

All 3D confocal images were represented as one z plane using Image>Stacks>Z 

Project>Projection type: Max intensity. 

 

2.2.7. Statistical analysis 

All data are shown either as individual samples and mean or as mean ± SD. All 

points represented individual organotypic slices. Means of variables (area of signal, total 

signal intensity and mean signal intensity) obtained from analysis of the identical conditions 

were compared using paired parametric one-tailed t-test analysis. Means of variables obtained 

from the comparison of different hM4D-mCherry virus loads were compared using unpaired 

parametric one-tailed t-test analysis. Differences were considered statistically significant 

when *p < 0.05 and very significant when **p < 0.005. These tests were performed using 

GraphPad Prism v6.0. software. 
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3. RESULTS 

In this study we aimed to implement a novel approach to analyze activity-dependent 

synaptic pruning in developing hippocampus. Synaptic pruning is a complex process 

mediated by a variety of factors but the most important one is considered to be microglia. 

Microglia is essential for normal synaptic network maturation and can phagocytose entire 

dendritic spines (Schafer et al., 2012) or axonal boutons as well as modify synaptic terminals 

(Weinhard et al., 2018). However, how exactly microglia choose which synapses are going to 

be modified is still unclear. Emerging research (Ge et al., 2006; Watanabe and Kano, 2011) 

indicates that neuronal activity might be the driving force behind this process and it works in 

a competition-driven mechanism. We hypothesized that microglia preferentially select and 

remove less active synapses reducing the density of axonal boutons and dendritic spines. 

Therefore, we aimed to develop an experimental approach to evaluate and to modify neuronal 

activity in developing hippocampus and to define its role in neuron-microglia interaction. 

Our experimental workflow was divided into three distinct parts. First, we 

established organotypic hippocampus slice cultures. Second, we visualized interactions 

between neurons and microglia. Finally, we optimized the conditions for the expression of 

designer receptor activated by designer drug that can be used to inhibit neuronal activity and 

to visualize axonal boutons and dendritic spines and that is delivered by utilizing AAV8/2-

CaMKIIα::hM4Di(Gi)-mCherry-WPRE-hgHp(A) DREADD construct (thereafter referred to 

as AAV-hM4D).  

 

3.1. Establishing experimental setting for the visualization of maturing 

neurons during the period of synaptic pruning 

3.1.1. Establishing organotypic hippocampus slice cultures 

Specific and complex environment is required to support neurons and microglia for 

prolonged period of time. OHSC is a well-known experimental 3D model for functional and 

morphological analysis of the nervous tissue (Linsley et al., 2019). It is known that OHSC 

undergo remarkably similar developmental steps in respective time periods compared to those 
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observed in vivo (Muller et al., 1993). Implementing slice cultures is a challenging task and 

many different protocols exits (Gogolla et al., 2006; Jang et al., 2018; Simoni and Yu, 2006).  

We based our protocol on two major research papers (Gogolla et al., 2006; Simoni 

and Yu, 2006). OHSC was prepared from postnatal day three (P3) mouse pups to ensure that 

we would be able to track and modify neuron activity during the peak period of synaptic 

pruning. Main steps of OHSC harvesting were the removal of skin and skull (Fig. 3.1 A,B), 

transfer of the brain to the dissection medium and cutting off the hemispheres (Fig. 3.1 C), 

extraction of the hippocampus (Fig. 3.1 D), slicing of the hippocampus to 300 μm slices (Fig. 

3.1 E) and placing slices on cell insert membrane (Fig. 3.1 F). Slices were cultured at 35 °C 

temperature to reduce microglial activation and phagocytic activity (Seo et al., 2012). Healthy 

slices showed typical hippocampal structure with distinguishable CA and DG regions (Fig. 

3.1 F). We observed slices for any signs of degradation or excess activation of microglia 

indicated by cell infiltration and change in morphology. 

Even though we based our protocol on published ones (Gogolla et al., 2006; Simoni 

and Yu, 2006), we believe we made several improvements. Previous studies have used a 

“cool-down” period after the dissection to reduce the inflammation and the activation of 

microglia. On the contrary to the published data, we observed significant reduction of slice 

viability after any increase in the length of dissection procedure. Furthermore, we believe our 

protocol has simplified the procedure and put a higher emphasis on speeding up the whole 

process.  
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Figure 3.1. Main steps of OHSC preparation: A – Removal of the skin from the skull; B – 

Removal of cartilage with exposed brain ready for extraction; C – Extracted brain in the 

dissection medium. Dashed lines shows the relative cut lines for separation of hemispheres, 

8× magnification; D – Medial side of cerebral hemisphere with exposed hippocampus marked 

with dashed lines, 12,5× magnification; E – Hippocampus placed on a tissue chopper ready 

for slicing; F – OHSC (DIV23) placed on a cell culture insert, magnification 40×. CA – 

Cornu Ammonis, DG – dentate gyrus. 
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Refined protocol allowed us to harvest organotypic slices and to culture them for 

extended periods of time (up to DIV23). Cultured slices preserved typical hippocampal slice 

structure (Fig. 3.1F). Distinguishable regions and normal neuron growth were observed (Fig. 

3.2).  

 

3.1.2. Visualization of developing excitatory pyramidal neurons  

To visualize excitatory pyramidal neurons Thy1::EGFP mice (Feng et al., 2000a) 

was utilized to prepare OHSC. This mouse line expresses EGFP in sparse populations of 

excitatory pyramidal neurons of the hippocampus. The expression of fluorescent protein was 

mediated by modified Thy1 gene regulatory elements and its expression increases during 

development (Feng et al., 2000). The density of EGFP-expressing neurons can be reduced by 

using heterozygous animals (Feng et al., 2000b). EGFP expression allowed us to visualize the 

maturation of CA1 neurons and their development over time (Fig. 3.2). Even in early days of 

culturing (DIV4-6, equivalent to P7-P9 in vivo) the increase of EGFP-expressing neurons was 

observed. The trend continued over the next 12 days with a significant increase in both the 

number and the fluorescence intensity of EGFP-expressing neurons.  
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Figure 3.2. Early EGFP expression in CA1 excitatory pyramidal neurons over DIV18. OHSC 

from Thy1::EGFP/+ animal. Circles highlight the area with the significant increase of EGFP-

expressing neurons. Wide-field fluorescence imaging.  

 

The number of EGFP-expressing neurons increased considerably (Fig. 3.2). This 

signifies that cultures remained viable during 18 DIV culturing. Emerging fluorescent neurons 

may also reflect neurogenesis. Under physiological conditions, there is no neurogenesis in the 

CA1 region of the hippocampus. However, neurogenesis of the CA1 pyramidal neurons has 

been previously reported as a result of hypoxia and tissue damage (as in the case of OHSC 

preparation) (Bendel et al., 2005; Nakatomi et al., 2002). In the future we intend to address 

this question by performing Ki-67 staining to check for the proliferation of neurons 

(Weissleder et al., 2016). 

After we showed that slices developed and remained viable during early culturing 

period, subsequently, we analyzed the viability of EGFP-expressing neuron over the period of 

synaptic pruning. It has been reported that synaptic pruning occurs between P15 (Paolicelli et 

al. 2011) and P21 (Jawaid et al. 2018) in vivo or at DIV16 – DIV19 in OHSC (unpublished 

data from our group) and is mostly finished by 28 days in vivo (Paolicelli et al. 2011). These 
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findings were supported by Weinhard and colleagues stating that phagocytic activity of 

microglia peaks at postnatal day 15 and drops by the day 28 of postnatal development 

(Weinhard et al., 2018). Hence, we cultured OHSC to DIV23 which is equivalent to P26 in 

vivo to include the period of the peak synaptic pruning (Fig. 3.3). 

 

Figure 3.3. Visualization of EGFP-expressing pyramidal neurons in the OHSC throughout 

the period of synaptic pruning. OHSC was prepared from Thy1::EGFP/+ animal. Expression 

of EGFP is controlled by Thy1 promoter regulatory units. Solid line arrows mark initially live 

neurons. Dashed arrows mark the spot where previously live neurons were located. Wide-

field fluorescence imaging. 

 

The visualization of neurons was facilitated by Thy1 promoter regulatory units that 

provided lifelong expression of EGFP. Majority of neurons maintained their viability 

throughout the entire experiment (up to DIV23) (Fig. 3.3). However, a small number of 

neurons could not be visualized during repeated imaging (Fig. 3.3) and thus were presumed to 

have been lost during culturing. Compared to early culture development, number of EGFP-

expressing neuron stayed similar. The distribution of EGFP-expressing neurons was sparse 
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during the period of intense synaptic pruning. This provided the possibility to track the 

maturation of the same neurons over time.  

Overall, OHSC maintained sufficient neuron viability during the period of synaptic 

pruning and therefore could be used to investigate neuron-microglia interactions in 

developing hippocampus. 

 

3.1.3. Visualizing dendritic spines and axonal boutons  

Next, we used confocal imaging to acquire high resolution images of OHSC. For 

confocal imaging Thy1::EGFP/+ samples have been fixed and placed on microscope slides. 

Confocal microscope has produced high resolution images through multiple vertical planes 

(Fig. 3.4 A, B). Such images allowed us to visualize and evaluate the morphology of axonal 

boutons and dendritic spines (Fig 3.4 C, D).  
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Figure 3.4. Visualization of (A) axonal boutons and (B) dendritic spines at DIV21. C – 4× 

zoom of axonal bouton demonstrating their state of maturation. I – small bouton. II – large 

multisynaptic bouton. D – 4× zoom of dendritic spines demonstrating their morphology.1 – 

dendritic filopodium, 2 – thin spine, 3 – stubby spine, 4 – mushroom-shaped mature spine. 

OHSC was prepared from Thy1::EGFP/+ animal and cultured for DIV21. A – projected from 

26 planes. B – projected from 24 planes. Confocal fluorescence imaging.  

 

Axonal boutons (Fig. 3.4 A, C) and dendritic spines (Fig. 3.4 B) with their 

characteristic variety of shapes were recognized in confocal images. It has been well 

established that there is a close relationship between axonal bouton and dendritic spine 

morphology and their function (Heck and Benavides-Piccione, 2015). Hence, we can 

investigate the function of axonal boutons and dendritic spines by analyzing their 

morphological characteristics. Acquired images showed small possibly less mature (Murthy et 

al., 2001) (Fig. 3.4 C, I) and significantly bigger multisynapse boutons (Fig 3.4 C, II) (Zhan et 

al., 2014). High number of dendritic spines observed in the sample suggested that culturing of 

the OHSC did not interfere with developmental synapse formation. Dendritic spines were 

observed in multiple stages of their maturation from synaptic precursors dendritic filopodia 
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(Fig. 3.4 D, 1) to already mature mushroom-shaped spines (Fig. 3.4 D, 4) (Lai and Ip, 2013). 

Acquired images were suitable for morphological assessment of synaptic morphology and did 

not require any signal-enhancing tools.  

  

3.2. Co-visualization of neurons and microglia 

Thy1::EGFP, RC::LSL-tdTomato, Cx3cr1::Cre triple transgenic mouse line was used 

to establish OHSC, in which both neurons and microglia could be imaged interacting with 

each other. This provided a unique system to investigate the function of microglia in 3D 

setting. Visualization of microglia is enabled by a red fluorescent tag tdTomato. The 

expression of tdTomato is initally blocked by a stop codon surrounded by loxP sequences 

(Luche et al., 2007). Induction of the tdTomato expression in microglia is regulated by an 

estrogen receptor modulator tamoxifen (Andersson et al., 2010). Fluorescence is activated 

only when the active form of tamoxifen, 4-hydroxytamoxifen, activates estrogen receptor 

(fused with Cre recombinase) and Cre is translocated into the nucleus . In the nucleus Cre 

removes the stop codon and enables tdTomato expression (Zhong et al., 2015). However, the 

inhibition of this expression is only partial and the system is considered to be “leaky” (Zhao et 

al., 2019). 

In our study, tamoxifen was added at DIV0 and OHSC were cultured for further 18 

days. We compared the density of microglia in organotypic slices with and without tamoxifen 

treatment (Fig. 3.5). Microglia density of tamofixen-treated OHSC was 18 cells/100 μm2. In 

contrast, in slices without tamoxifen density of microglia was 6.4 cells/100 μm2. Overall, the 

application of tamoxifen increased the number of visible microglia by 2.8 times in DIV18 

samples.  
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Figure 3.5. OHSC from Thy1::EGFP, RC::LSL-tdTomato, Cx3cr1::Cre with and without 

tamoxifen treatment at DIV18. tdTomato-expressing microglia in CA1 and DG regions of the 

hippocampus. CA – cornu Ammonis, DG – dentate gyrus. Wide-field fluorescence imaging. 

 

Due to a “leaky” promoter we had different microglia densities with and without 

tamoxifen treatment. Therefore we could investigate microglia in two different ways. First, 

without tamoxifen, the density of microglia remained relatively low and we could investigate 

the morphology of individual microglia, which is closely related to their function (Fernández-

Arjona et al., 2017). Second, the addition of tamoxifen increases the number of visible 

microglia to almost 90% (Álvarez-Aznar et al., 2020) and is better suited to analyze direct 

contacts between neurons and microglia due to increased density of such contacts. To confirm 

the published data of tamoxifen efficiency we are planning to perform microglia-specific Iba1 

co-staining to quantify tdTomato-positive microglia (Fernández-Arjona et al., 2017). 

Confocal imaging of slices without tamoxifen was performed to acquire high-detail 

image of microglia (Fig. 3.6). EGFP signal showed healthy maturing synaptic network (Fig. 

3.6 A). Imaging of tdTomato signal allowed for better inspection of complex morphology of 

microglial protrusions (Fig. 3.6 B). The overlay of EGFP and tdTomato allowed us to inspect 

direct points of neuron-microglia interaction (Fig. 3.6 C, D).  
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Figure 3.6. Neurons and microglia maintain close connections in OHSC. A – EGFP-

expressing pyramidal excitatory neurons. B – tdTomato labels intricate structure of microglia. 

C – the overlay of EGFP and tdTomato signals shows overall distribution of microglia and 

neurons. D – 16× zoomed protrusion of microglia co-localized with a dendrite. Dashed square 

shows magnified area in D. Dashed oval highlights the co-localization of microglia and 

neuron. CA1 region in the hippocampus. Images projected from 28 planes. Confocal 

fluorescence imaging. 

 

Furthermore, OHSC with labeled microglia and neurons can be combined with a 

variety of different molecular tools desgined to modify or visualize the activity of neurons. It 

provides unique opportunity to observe active role of microglia in the remodelling of synaptic 

networks. 
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3.3. Setting up DREADD-mediated inhibition of neural activity  

After we have established a method for long term culturing and visualization of 

neurons and microglia, we used inhibitory DREADD (hM4D) to examine the effect of 

reduced neuronal activity for developmental remodeling of the circuitry. We chose AAV8/2-

CaMKIIα::Hm4Di(Gi)-mCherry-WPRE-hgHp(A) DREADD construct. Adeno associated 

virus serotype 8 was used to ensure high level of infection in neurons (Hammond et al., 

2017). Our AAV-hM4D construct had calmodulin kinase II α promoter, which is expressed in 

excitatory pyramidal hippocampal neurons. Our AAV-hM4D construct had fluorescent 

protein mCherry which is fused with DREADD to track its localization and the level of 

expression. Woodchuck hepatitis virus posttranscriptional regulatory element (WPRE) 

increases the expression of the whole construct (Zufferey et al., 1999). Human growth 

hormone polyadenylation signal (hgHp(A)) enhanced polyadenylation and termination of 

construct sequence (Gubler et al., 1983). Activation of our AAV-hM4D construct was 

mediated by a synthetic ligand CNO (Zhu and Roth, 2014).  

Our DREADD allowed us to specifically analyze pyramidal neuron circuitry 

preserved in the organotypic slices. Specifically, we investigated the synapses between the 

pyramidal neurons from CA3 region, which project axons, called Shaffer collaterals, and 

pyramidal neurons of CA1 region. Since, both CA1 and CA3 neurons can potentially be 

inhibited by the DREADD, it provides a suitable research setting to analyze both presynaptic 

(axonal boutons) and postsynaptic (dendritic spines) compartments. All following 

experiments were performed using OHSC harvested from Thy1::EGFP mouse line in which 

EGFP worked as an internal control to establish the morphology of axonal boutons and 

dendritic spines with unaffected synaptic activity. 

Optimized conditions for AAV-hM4D infection of OHSC were vital for the best 

possible artificial receptor expression. Expression of hM4D-mCherry was tracked using 

fluorescent protein mCherry which has a physical link with the artificial receptor. Expression 

of hM4D-mCherry has been paramount for successful inhibition of neuronal activity. Also, 

we expected that reliable expression of hM4D- would allow us to visualize dendritic spines 

and axonal boutons and to enable their morphological evaluation after the alteration of 

neuronal activity. To achieve this goal many practical and physiological considerations have 

been addressed. First, inhibition of neuronal activity by the activation of hM4D should 

correspond to the peak of synaptic pruning which is known to occur between P15 (Paolicelli 

et al., 2011) and P21 (Jawaid et al., 2018) in vivo or at DIV16 – DIV19 in OHSC 
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(unpublished data from our group). Second, experimental timeline has to end before DIV25 

(which corresponds to P28 for live animals) which marks the end of significant synaptic 

remodeling in the hippocampus (Paolicelli et al., 2011). Third, the integration, synthesis and 

transportation of the hM4D-mCherry  into the distal parts of the neuron could take up to 7 – 

14 days (Cǎlin et al., 2018; Lu et al., 2011). Also, in published studies inhibition of neural 

activity by CNO has been usually maintained for 24 h (López et al., 2016a) and then samples 

had to be cultured for 3 more days to achieve observable morphological changes (Koyama et 

al., 2017). According to these criteria primary experimental scheme was constructed (Fig. 

3.7).  

 

Figure 3.7.  Experimental timeline for hM4D-mCherry expression in OHSC. 

 

First, we decided to gather OHSC from 3 day old mice. Second, we had to decide on 

the day of infection and the amount of AAV-hM4D construct that would yield optimal 

expression of hM4D-mCherry. Third, we had to determine time required for sufficient hM4D-

mCherry expression to inhibit neuronal activity using CNO. OHSC had to be cultured with 

CNO for 24 h and further 3 days of culturing were required for morphological changes in 

axonal boutons and dendritic spines. Finally, the experiment must be finished before DIV25. 

 

3.3.1. Selecting the day for AAV-DREADD infection 

To optimize the timeline of AAV-DREADD experiment, first we had to decide on 

which day after slice preparation the virus should be added to OHSC. On one hand, the 

earliest possible infection day provides us with the longest period of DREADD expression. 

Therefore, it ensures that DREADD is efficiently transported into distal parts of dendrites and 

axons. Furthermore, it provides artificial receptors with enough time to be integrated into the 

membrane, which is required to exert their inhibition of neural activity. Finally, viral particles 

penetrate organotypic slices easier on earlier days of infection due to the fact glial scar 
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continues to form until DIV5 (Gerlach et al., 2016). However, early day of infection might 

impede efficient expression of hM4D-mCherry. First, harvesting of OHSC produces 

significant amount of cell debris on top of the slice. These remains of neurons get infected by 

AAV-hM4D and reduce virus load on the healthy neurons located deeper in the slice. Later 

during culturing, this debris gets removed. Second, dissection damages the tissue, stimulating 

inflammatory microglial activation, increasing phagocytic activity and thus hindering 

effective AAV infection. Later day of infection reduces the time allowed for DREADD 

expression but mostly bypasses the infection of debris and initial microglia activation 

problems. 

First, early date of infection (DIV1) (Avaliani et al., 2016; Weinhard et al., 2018) and 

9 x 108 vg virus load were selected based on research made using similar AAV-DREADD 

constructs (Boehringer et al., 2017) (Fig. 3.8). 

 

 

Figure 3.8. Timeline of DREADD experiment with DIV1 AAV-hM4D treatment date, 9 x 

108 vg virus load and confocal fluorescence imaging at DIV12. 

 

Selected virus load (9 x 108 vg) was higher compared to that used by other 

researchers (Alberto J López with collegues used 2.3 x 108 vg) in experiments utilizing similar 

DREADD constructs (López et al., 2016a) . This ensured more than sufficient amount of viral 

particles for every slice. However, 11 days after infection (DIV12) there was no mCherry 

expression as evaluated by confocal microscopy, even though the slices maintained normal 

viability and morphology of Thy1::EGFP neurons (Fig. 3.9). This lack of hM4D-mCherry 

fluorescence was likely caused by the majority of viral particles infecting cellular debris. 
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Figure 3.9. No mCherry expression was observed after 11 days of DIV1 AAV-hM4D 

infection. Control sample was cultured without any treatment. EGFP images projected from 

33 planes. mCherry images projected from 24 planes. Confocal fluorescence imaging.  

 

Next, we decided to delay the infection to DIV5 using the same AAV-hM4D virus 

load (9 x 108 vg) and evaluated the slices on DIV12 using wide-field microscopy (Fig. 3.10). 

 

 

Figure 3.10. Timeline of DREADD experiment with AAV-hM4D infection at DIV5 and 

wide-field fluorescence imaging at DIV12. 
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DIV5 for AAV-hM4D infection was chosen due to several reasons. First, cellular 

debris and dead cells are removed during the first week in vitro (Simoni and Yu, 2006). 

Second, the expression of CamKIIα which was employed as a promoter to regulate expression 

of our AVV-hM4D construct is low at P4 (DIV1) (Kelly and Vernon, 1985). CamKIIα 

expression in excitatory pyramidal neurons of hippocampus is minimal in the first postnatal 

days and starts to increase by fifth postnatal day (Kelly and Vernon, 1985). Seven days after 

infection (at DIV12) weak but observable mCherry fluorescent signal was seen in infected 

slices (Fig. 3.11).  

 

Figure 3.11. mCherry expression after 7 days of DIV5, 9 x 108 vg virus load infection of 

AAV-hM4D. Wide-field fluorescence imaging. 

 

hM4D-mCherry was distributed throughout the entire cornu Ammonis and dentate 

gyrus. Overall, primary data showed that detectable hM4D-mCherry expression could be seen 

after 7 days of expression when OHSC treatment was performed at DIV5. These results 

strongly suggested that infection of slices should be performed no earlier than DIV5.   
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3.3.2. Time profile of hM4D-mCherry expression 

Next, we evaluated the expression profile of hM4D-mCherry. Since our construct has 

a physical link between fluorescent tag mCherry and the artificial receptor we expected that 

better neuronal inhibition could be achieved when higher mCherry fluorescence was 

observed. DREADD expression is regulated by CamKIIα promoter which activity is known to 

increase 10-fold from P5 to P25 (Kelly and Vernon, 1985), therefore AAV-hM4D expression 

should also significantly increase during the same period. We showed observable mCherry 

signal 7 days (DIV12) after infection (Fig 3.11). To define whether expression continues to 

grow till the start of peak synaptic pruning (DIV16) (unpublished data from our group), three 

time points were chosen: 8, 10, 11 days after infection (DIV13, DIV15, DIV16) to follow the 

expression of AAV-hM4D over time and to select the time for hM4D activation (Fig 3.12). 

 

Figure 3.12. Timeline to establish time profile of AAV-hM4D expression using DIV5 

treatment of AAV-hM4D and 9 x 108 vg virus load. 

 

The expression of AAV-hM4D was analyzed in three slices (S1, S2, S3) (Fig. 3.13). 

The fluorescence of mCherry was observed in the CA1, CA2, CA3 and DG regions of the 

hippocampus and a consistent growth of signal was detected from day 8 to day 11 after 

infection with 9 x 108 vg virus load AAV-hM4D at DIV5. 
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Figure 3.13. mCherry expression over time. Three slices (S1, S2, S3) were imaged 8, 10, 11 

days (DIV13,15,16) after 9 x 108 vg load of AAV-hM4D infection at DIV5. DG – dentate 

gyrus, CA – cornu Ammonis. Wide-field fluorescence imaging. 
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The fluorescence of hM4D-mCherry over time was then measured to obtain 

quantitative data. We were not able to segment individual cells expressing mCherry 

fluorescent protein, in wide-field EVOS microscope images; therefore, we evaluated total 

fluorescence in CA1 – CA3 region of hippocampus. The ROI was designed based on 

hippocampal circuitry data (Fig. 3.14 A, B), individual shape of the slices (Fig. 3.14 C) and 

the rotation of slices (Fig. 3.14 D). ROI was selected to include CA1b-CA3b (Fig. 3.14 A) str. 

pyramidale, str. radiatum, str. lacunosum-moleculare molecular layers of the hippocampus 

(Fig. 3.14 B). Str. pyramidale contains cell bodies of the excitatory pyramidal neurons, str. 

radiatum and str. lacunosum-moleculare holds the entire dendritic tree of the same neurons 

which form synapses with Schaffer collaterals that are forward projections of CA3 pyramidal 

neurons. Selected ROI was customized to all slices analyzed in our experiments (6 slices) 

over time (Supp. Fig. 1).  
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Figure 3.14. Defining ROI for OHSC image analysis. CA – cornu ammonis, DG – dentate 

gyrus, SP – stratum pyramidale; SR – stratum radiatum, SLM – stratum lacunosum-

moleculare, SL – stratum lucidum, SG – stratum granulosum. A – distribution of CA regions 

throughout hippocampus (Conrad, Ortiz, & Judd, 2017). B – molecular layers of the 

hippocampus, adapted from Li and Pleasure, 2013 (Li and Pleasure, 2013). C – establishing 

hippocampal regions in OHSC. D – adjusting ROI to individual images. Wide-field 

fluorescence imaging. 
  

Subsequently, ROI was applied to OHSC of 9 x 108 vg virus load group (three slices 

8, 10, 11 days after AAV-hM4D infection at DIV5) (Fig. 3.15). Fluorescent area, normalized 

fluorescence intensity and mean fluorescence intensity were measured in this ROI.  
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Figure 3.15. ROIs (corresponding to CA1b-CA3b regions) from slices treated with of 9 x 108 

vg virus load of AAV-hM4D at DIV5 for quantification of mCherry fluorescence over time. 

Wide-field fluorescence imaging. 

 

First, the total area of fluorescence was measured of three OHSC to evaluate the 

evolution of mCherry signal over time (Fig. 3.16). In general, steady increase of total area was 

noticed over three time points in all three samples. Samples showed relatively similar 

mCherry signal area at 8 days after infection (DIV13) but displayed vastly different signal 

area by 11 days after infection (DIV16). On average, total area increased by 5.9 times (p = 

0.045) from DIV13 to DIV16. Also, the increase in fluorescent area was greater between 

period of 10 – 11 days (DIV15 – DIV16) compared to 8 – 10 days (DIV13 – DIV15) after 

infection. Increase in fluorescent area could signify more cells expressing hM4D-mCherry 
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over time. Also, it could correspond with hM4D-mCherry transportation into distal parts of 

the cell (axon and dendrites).  

 

Figure 3.16. Total area of mCherry fluorescence signal in CA1b-CA3b regions 8-11 days 

after AAV-hM4D infection. N = 3, * p < 0.05. 

 

Then, total fluorescence intensity was evaluated over time (Fig. 3.17). We observed 

similar trend compared to the total fluorescent area with higher increase of intensity during 

the period of 10 – 11 days (DIV15 – DIV16) compared to 8 – 10 days (DIV13 – DIV15). 

Average intensity increased by 6.7 times (p = 0.040) from 8 to 11 days (DIV13 – DIV16) 

after the infection. Overall, data indicated significant increase in the amount of fluorescent 

protein mCherry. This might be due to the increasing activity of CamKIIα promoter during 

the same period of hippocampal development (Kelly and Vernon, 1985). 
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Figure 3.17. Total fluorescence intensity in CA1b-CA3b regions 8-11 days after AAV-hM4D 

infection. N = 3, *p < 0.05. Normalization was done by dividing the total fluorescence 

intensity of all points by the value of lowest total intensity. 

 

Finally, to evaluate whether fluorescence intensity in a single neuron is increasing 

over time, we evaluated average fluorescence intensity per pixel of the mCherry signal area 

(Fig. 3.18). Mean intensity value significantly increased by 1.15 times (p = 0.002) from 8 to 

11 days after infection. Even though, this change is minute, it signifies that increase of 

average intensity is greater than the increase of average area. Furthermore, this clarifies that 

the synthesis of new fused hM4D-mCherry proteins takes place in neurons over time. 

 

Figure 3.18. Mean fluorescence intensity in CA1b-CA3b regions 8-11 days after AAV-

hM4D infection. R.F.U. – relative fluorescence units. N = 3, **p < 0.005. 
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Overall, our data demonstrated that mCherry fluorescence (and presumably the 

number of artificial receptors capable of inhibiting neural activity) increased in neurons from 

8 to 11 days after DIV5 infection of 9 x 108 vg virus load AAV-hM4D. Since day 11 after 

infection showed the highest mCherry signal, we decided that DIV16 is sufficient to perform 

activation of DREADD by CNO.  

 

3.3.3. Defining AAV-hM4D virus load for optimal hM4D-mCherry 

expression 

For our initial experiments we chose high (9 x 108 vg) AAV-hM4D virus load to 

ensure high chance of infection. Next, we compared 9 x 108 vg virus load with to 3,6 x 108 vg 

virus load to reduce hM4D-mCherry expressing neuron density and to enable visual isolation 

of individual hM4D-mCherry-expressing neurons. To assess morphological characteristics of 

dendritic spines and axonal boutons, individual neurons with minimally overlapping 

processes and high fluorescent signal intensity are required. Using 9 x 108 vg virus load 

(Fig.3.13) we observed overlapping neurons with no clear definition. Therefore, we compared 

mCherry fluorescence 11 days after (DIV16) AAV-hM4D application of different (9 x 108 vg 

and 3,6 x 108) virus loads (Fig. 3.19). 

 

 

Figure 3.19. Timeline to define AAV-hM4D virus load for optimal density of hM4D-Cherry-

expressing neurons after DIV5 treatment. 

  

Three slices of 9 x 108 vg virus load and two of 3.6 x 108 vg were analyzed. The 

density of neurons expressing hM4D-mCherry was lower when slices were infected with 3.6 

x 108 vg virus load (Fig. 3.20). 
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Figure 3.20. ROIs (corresponding to CA1b-CA3b regions) from slices treated with 3.6 x 108 

vg and 9 x 108 vg virus loads at DIV5. 11 days after infection (DIV16). Wide-field 

fluorescence imaging. 

 

We applied the same ROI (described in 3.3.2) to all five samples to ensure uniform 

measurement area and the selection of identical locations of CA1b-CA3b regions. We 

compared virus loads 11 days after AAV infection (DIV16) to get the highest signal intensity 

within individual neurons. As before, we evaluated mCherry fluorescent area, total 

fluorescence intensity and mean signal intensity. 

We measured total area of hM4D-mCherry fluorescence using data acquired from 

five slices (Fig. 3.21). As expected, lower AVV-hM4D virus load reduced the area of the 

fluorescence on average two times. This decrease of total area might be caused by two factors. 

First, lower AAV-hM4D virus load might have lowered the number of infected pyramidal 

neurons. Second, lower AAV-hM4D virus load might have slowed down the expression of 

mCherry in individual neurons, thus less hM4D-mCherry would have been distributed inside 

the neuron, therefore reducing total area. 
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Figure 3.21. Total area of hM4D-mCherry fluorescence in organotypic slices infected with 

different virus loads 11 days after infection. 3,6 x 108 vg N = 2, 9 x 108 vg N = 3. 

 

We measured total fluorescence intensity of 3,6x108 vg and 9x108 vg virus loads 

(Fig. 3.22). Difference of total intensity between different virus load groups was 2.1 times on 

average (p = 0.100). To check if the decline in total fluorescence intensity was caused only by 

the reduction of hM4D-mCherry-expressing neuron number area of fluorescence, mean 

fluorescent intensity was measured. 

 

Figure 3.22. Total intensity of hM4D-mCherry fluorescence in organotypic slices infected 

with different virus loads 11 days after infection. 3,6 x 108 vg N = 2, 9 x 108 vg N = 3. 

Normalization was done by dividing the total fluorescence intensity of all points by the value 

of lowest total intensity. 
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We measured mean intensity in different virus load groups to check how reduction in 

virus load affected the intensity of the fluorescence within hM4D-mCherry-expressing 

neurons (Fig. 3.23). The reduction of virus load reduced the mean intensity only by 1.03 times 

(p = 0.074).  

 

Figure 3.23. Mean intensity of hM4D-mCherry fluorescence in organotypic slices infected 

with different virus loads 11 days after infection. R.F.U. – relative fluorescence units.  3,6 x 

108 vg N = 2, 9 x 108 vg N = 3. 

 

Overall, the reduction of virus load lowered the area of hM4D-mCherry fluorescent 

signal by 50.4% on average. In contrast, the reduction of mean intensity was only 8.9%. 

Hence, smaller virus load (3,6 x 108 vg) reduced the number of hM4D-mCherry-expressing 

neurons and had low impact on individual neuron fluorescent intensity. This increased 

chances of observing isolated neuron with non-overlapping axons and dendrites. Based on 

this data lower (3.6 x 108 vg) virus load was chosen for further experiments. 

 

3.3.4. High resolution visualization of neurons expressing hM4D-mCherry 

after 3,6 x 108 vg virus load  

We have established that effective hM4D-mCherry expression requires at least 11 

days after infection, but further 24 h are needed to activate the DREADD and extra three days 

are required to observe any changes in axon bouton and dendritic spine density and 
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morphology (unpublished data from our team). Hence, 3,6 x 108vg virus load slices analyzed 

in chapter 3.3.3 were cultured until DIV20, fixed and prepared for confocal imaging (Fig. 

3.24) (preparation described in chapter 2.2.2.). 

 

Figure 3.24. Timeline used for preparation of slices with 3,6 x 108vg AAV-hM4D virus load 

after DIV5 treatment for confocal imaging. 

 

 Immunofluorescent staining was applied to amplify mCherry fluorescent signal with 

minimal increase in background fluorescence (Supp. Fig. 2).  Amplifying the signal is crucial 

due to low quantum yield of the mCherry compared to other frequently utilized fluorescent 

proteins (Shaner et al., 2005). Acquired images allowed us to observe hippocampal excitatory 

pyramidal neurons (Fig. 3.25 A). hM4DmCherry-expressing neurons were located close to 

each other with rare non-overlapping neurons (Fig. 3.25 A). Branching dendrites were seen 

but these were dense and overlapping (Fig. 3.25 B). However, fluorescent signal was too poor 

to visualize smaller structures, such as dendritic spines or axonal boutons (Fig. 3.25 B). 
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Figure 3.25. 3,6 x 108 vg virus load slice after DIV20.  Excitatory pyramidal neuron in the 

CA1 region of the hippocampus. Immunofluorescent staining of mCherry was applied to 

amplify the signal. Neurons were visualized in red since neurons express mCherry signal 

amplified with Alexa568. A- excitatory pyramidal neuron. B- dense network of dendrites. A – 

projected from 16 planes. B – projected from 12 planes. Confocal fluorescence imaging. 

 

Further reduction of viral load is required to reduce number of hM4D-mCherry-

expressing neurons and visualize non-overlapping axons and dendrites.  

 

3.3.5. Establishing increasing mCherry fluorescence in the neurons up to 15 

days (DIV20) after infection  

At this point we established that further reduction in virus load is needed to reduce 

density of hM4D-mCherry-expressing neurons and acquire sparsely labeled axon boutons and 

dendritic spines. Also, we showed the tendency for mCherry fluorescence to increase in 

individual cells over time. If the fluorescent signal of hM4D-mCherry kept increasing after 11 

days post infection, increased culturing time might improve signal to noise ratio.  

To reliably determine how hM4D-mCherry fluorescent signal intensity increases 

from 11 (DIV16) to 15 (DIV20) days after infection we isolated CA1b-CA3b regions (Supp. 

Fig. 3) and measured mean intensity of fluorescence. We used DIV5 infection of AAV-hM4D 

and 3,6 x 108 vg virus load (Fig. 3.26). This measurement was selected to analyze if 

increasing time of culturing after infection with AAV-hM4D by four days (from DIV16 to 
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DIV20) could increase fluorescence intensity in hM4D-mCherry-expressing neurons after 

DREADD activation at DIV16. 

 

Figure 3.26. Timeline to analyze expression of hM4D-mCherry (3,6 x 108 vg virus load) from 

11 (DIV16) to 15 (DIV20) days after DIV5 treatment with AAV-hM4D. 

 

Mean intensity of fluorescence increased by 1.15 times (13 %) (p = 0.026) between 

day 11 (DIV16) and day 15 (DIV20) after infection (Fig. 3.27). This indicates that increase of 

time of culturing from 11 days to 15 days (from DIV16 to DIV20) increased mCherry signal 

intensity of hM4D-mCherry-expressing neurons. 

 

Figure 3.27.  Mean intensity of hM4D-mCherry fluorescence in organotypic slices after 11 

(DIV16) and 15 days (DIV20) of 3,6 x 108 vg virus load infection. 11 days after infection N = 

3, 15 days after infection N = 3. R.F.U. – relative fluorescence units. *p < 0.05. 

 

We measured mean intensity at 11 days (DIV16) after infection since it provides 

with sufficient expression of DREADDs (described in chapter 3.3.3.) and at 15 days (DIV20) 
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after infection since we image neurons four days after activation of DREADD.  Overall, mean 

fluorescence intensity significantly increased from day 11 (DIV16) to day 15 (DIV21) of 

culturing which suggested increased mCherry fluorescence in neurons expressing hM4D-

mCherry.  

 

3.3.6. Reducing the density of hM4D-mCherry-expressing neurons and 

maximizing time for hM4D-mCherry expression 

After analyzing hM4d-mCherry expression in infected neurons (in chapter 3.3.2 and 

3.3.5) and the effect of reduced virus load for hM4D-mCherry expression in the slice, we 

further lowered virus load of AVV-hM4D to 1.8 x 108 vg to reduce the density of hM4D-

mCherry-expressing neurons. This could reduce number of overlapping hM4D-mCherry-

expressing neurons and help visualize axons and dendrites. We have previously observed that 

hM4D-mCherry signal in individual neurons increased up to 15 days after infection. Hence, 

we increased time of culturing to 14 days (DIV19) which corresponds with the last day of 

peak synaptic pruning (unpublished data from our group) (Fig. 3.28). This represents the 

maximum culturing period before we could apply CNO for the inhibition of neuronal activity. 

Neurons were then treated with CNO for 24 h and slices were fixed, stained to amplify 

mCherry signal and imaged at DIV23.  

 

Figure 3.28. Experimental timeline showing reduced virus load (1.8 x 108 vg) after treatment 

of AAV-hM4D at DIV5 and increased time of culturing before CNO treatment to 14 days.  . 

 

Images of hM4D-mCherry-expressing CA1 pyramidal neurons were captured using 

confocal microscopy. Despite the lowered AAV-hM4D virus load on a slice to 1.8 x 108 vg, 

hM4D-mCherry-expressing neurons overlapped and were tightly packed (Fig. 3.29). Also, 

increased time of culturing to 18 days after infection (DIV23) with AVV-hM4D, did not 
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result in the accumulation of sufficient amount of mCherry to clearly visualize axons or 

dendrites (Fig. 3.29). 

 

Figure 3.29. hM4D-mCherry-expressing excitatory pyramidal neurons in the CA1 region of 

the hippocampus. Slice was treated with 1.8 x 108 vg virus load and cultured for 18 days after 

infection (DIV23). mCherry signal was amplified with immunofluorescent staining. Image 

projected from 25 planes. Confocal fluorescence imaging. 

 

3.3.7. Determining optimal day of AAV-hM4D infection for visualization of 

axonal boutons and dendritic spines 

Based on our previous experiments and the increasing expression of our DREADD 

promoter CamKIIα we hypothesized that the day of infection was a more important for robust 

expression of DREADD than the following incubation time. To test this hypothesis the same 

(1.8 x 108 vg) virus load infections were performed on DIV5, 7, 12. Samples were then fixed, 



 

  62 

immunofluorescent staining was performed to amplify mCherry signal and slices were imaged 

at DIV 23, 22, 22 accordingly (Fig. 3.30). 

 

Figure 3.30. Experimental timeline used to compare the effect of date of AAV-hm4D 

infection. We used 1.8 x 108 vg virus load at DIV5, 7, 12 dates of infection.  

 

We selected the brightest neurons in every experiment from the CA1 region of the 

hippocampus (Fig. 3.31). DIV5 infection showed poor mCherry signal in the somas of 

pyramidal neurons with almost no possibility to visualize neurites (Fig. 3.31). DIV7 infection 

exhibited a slight improvement with better defined shape and observable migration of 

mCherry into more distal parts of the neuron (Fig. 3.31). The sample infected at DIV12 

provided the highest fluorescent intensity by far with fully homogeneously labeled somas and 

branching dendrites (Fig. 3.31). Interestingly, the sample infected at DIV12 was cultured only 

for 10 days after infection as compared with DIV5 which was cultured for 18 days. Overall, 

the time of infection had higher impact on the strength of hM4D-mCherry fluorescence 

compared to the length of culturing after the infection with AAV-hM4D. 
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Figure 3.31. hM4D-mCherry-expressing neurons after DIV5, DIV7, DIV12 infection with 

1.8 x 108 vg virus load. Pyramidal neurons expressing hM4D-mCherry located in CA1 region. 

mCherry signal was amplified using immunofluorescent staining. Top left corners show the 

date of AAV-hM4D infection. DIV5 image projected from 25 planes. DIV7 projected from 50 

planes. DIV12 image projected from 60 planes. Confocal fluorescence imaging. 

 

In the sample, which was infected at DIV12, branching dendrites were observed (Fig. 

3.32 A), even dendritic spines could be distinguished (Fig. 3.32 B). Nevertheless, the quality 

of the signal was too poor to perform morphological analysis of dendritic spines. 
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Figure 3.32. Visible dendrites after DIV12 infection with 1.8 x 108 vg virus load. Originating 

in neurons expressing hM4D-mCherry from CA1 region molecular layer. mCherry signal was 

amplified using immunofluorescent staining. A – branching secondary apical dendrites. B – 

dendritic spines can be observed protruding from the dendrite. A – projected from 47 planes. 

B – projected from 16 planes. Confocal fluorescence imaging. 

 

Quantitative timeline of DREADD expression has been established with a notable 

increase in mCherry signal area and intensity throughout experimental period. Reduction in 

virus load from 9 x 108vg to 1.8 x 108 vg had minimal effect on the density of hM4D-

mCherry-expressing neurons. Highest possible day of infection produced the best mCherry 

signal in the pyramidal neurons. In fact, the day of infection was discovered to be the most 

important factor for the expression of hM4d-mCherry. However, the day of infection could 

not be further delayed since neural activity has to be inhibited during the period of synaptic 

pruning. 

Overall, we delayed the day of AAV-hM4D application to DIV12, increased the time 

culturing after infection to 15 days and reduced the virus load on a slice to 1.8 x 108 vg. Even 

though, these changes had improved the quality of the signal, morphological analysis of either 

dendritic spines or axonal boutons were impossible to perform due to insufficient resolution 

of the signal. Deficient imaging of smaller structures might be caused by high infected neuron 

count, low expression of hM4D-mCherry and a physical link between DREADD and 

fluorescent marker mCherry. Physical link allowed us to visualize only the area where the 

DREADD receptor was located. We had to conclude, that AAV8/2-CaMKIIα::Hm4Di(Gi)-
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mCherry-WPRE-hgHp(A) DREADD construct was not suitable for high resolution imaging 

experiments, morphological analysis of dendritic spines or axonal boutons. 

 

3.3.8. Co-localization of EGFP and mCherry fluorescence signals as a 

strategy to analyze infected neuron morphology 

Even though our AVV-DREADD construct is not suitable for the quantification and 

morphological analysis of dendritic spines or axonal boutons, it can still be utilized to inhibit 

the activity of the neurons (Alexander et al., 2018). Visualizing could be performed by using 

different fluorescent marker. In our work we used Thy1::EGFP mice that have excitatory 

hippocampal neurons labelled with EGFP marker. EGFP exhibits excellent imaging 

properties with more than 2 times higher brightness and quantum yield than mCherry (Shaner 

et al., 2005). It does not have any known effect on the viability or activity of the neurons. 

Most importantly, EGFP in this mouse line is not bound by any intracellular proteins and 

diffuses freely and efficiently throughout the cell. The only challenge is to localize mCherry 

and EGFP in the same neuron and in the region of our interest (CA1, CA3). While 

reanalyzing images from the previous experiments a neuron with clear co-localization of 

mCherry and EGFP was found (Fig. 3.33).  
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Figure 3.33. Co-localization of EGFP and mCherry signals. Slice was treated with AAV-

hM4D at DIV7 with 1.8 x 108 vg and cultured for 15 days after infection. Solid line square 

shows neuron expressing mCherry and EGFP. Dotted line squares highlight neurons 

expressing only mCherry. Images projected from 29 planes. Confocal fluorescence imaging. 

 

Unfortunately, this was a single neuron and subsequent experiments are required to 

test the feasibility of our approach. Nonetheless, this neuron shows how EGFP-mCherry co-

localization can be used to obtain images of well-defined axonal boutons and dendritic spines. 

To achieve high number of EGFP-mCherry double positive neurons we have to increase 

number of both EGFP and mCherry expressing neurons. Furthermore, Feng and colleagues 

reports that that only less than 10% of the hippocampus excitatory neurons are expressing 

EGFP in heterozygous animals and the number of EGFP positive neurons could be increased 

by using homozygous mice (Feng et al., 2000a). Hence, future experiments are only going to 
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be performed using homozygous animals. Finally, to further increase chance of EGFP-

mCherry co-localization 9 x 108 vg virus load of hM4D-mCherry is going to be used. 

Summarizing all our experiments to improve the density of EGFP+/mCherry+ 

double positive neurons we defined the timeline of experiment presented in Fig. 3.34. 

Timeline encompasses DIV7 infection day with CNO treatment at 11 days post infection 

(DIV18). The highest used virus load of AAV-hM4D (9 x 108 vg) was selected to increase the 

density of DREADD-expressing pyramidal neurons. Homozygous EGFP animals were 

selected to increase number of EGFP expressing pyramidal neurons. 

 

Figure 3.34. Experimental timeline constructed for mCherry-EGFP co-localization 

experiment. EGFP/EGFP animals were selected. We chose DIV7 day of AAV-hM4D 

infection with 9 x 108 vg. DREADD would be activated on DIV18 and could be imaged on 

DIV22. 

 

To conclude, our data showed that AAV8/2-CaMKIIα::hM4Di(Gi)-mCherry-WPRE-

hgHp(A) DREADD construct is not suitable for detailed imaging analysis of axonal boutons 

and dendritic spines. However, this AAV-hM4D construct can still be used in combination 

with different fluorescent labeling tools. Also, we provided timeline and conditions for future 

research. 
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4. DISCUSSION 

In this study we developed tools and strategies to investigate the role of neural 

activity in synaptic pruning. First, we established the protocol for organotypic hippocampus 

slice cultures to have an experimental 3D model for morphological analysis of axonal boutons 

and dendritic spines. Second, we visualized active interactions between neurons and 

microglia. Third, we explored different conditions for expression of AAV8/2-

CaMKIIα::hM4Di(Gi)-mCherry-WPRE-hgHp(A) DREADD construct. Finally, we proposed 

a co-localization of EGFP-mCherry signals as a strategy to analyze morphology of axonal 

boutons and dendritic spines of neurons with inhibited neuronal activity during the period of 

peak synaptic pruning. 

In our OHSC protocol we used P3 Thy1::EGFP/+ mouse pups compared to Gogola 

and colleagues which used P6 – P9 animals (Gogolla et al., 2006). Using younger animals 

was more difficult from a technical standpoint since the tissue was more fragile. Nevertheless, 

the slices we made were undamaged and preserved hippocampal structure was seen up to 

DIV23 with no signs of degradation. Increasing number of EGFP-expressing neurons was 

seen during culturing, indicating healthy tissue development. Neurons matured and 

maintained viability with minimal cell death up to DIV23. This is similar to the results of 

Poindron and colleagues (Poindron et al., 2005), who cultured slices for DIV12 or Muller and 

colleagues (Muller et al., 1993), who reported healthy neurons in 2 – 3 week old slices. To 

achieve this, we significantly simplified and sped up preparation procedure. We believe that 

the changes we made improved previously published protocols (Gogolla et al., 2006; Simoni 

and Yu, 2006).  

We visualized the interactions between microglia by utilizing Thy1::EGFP, 

RC::LSL-tdTomato, Cx3cr1::Cre triple transgene mouse line. Density of tdTomato-

expressing microglia was controlled by application of tamoxifen. Our results were similar to 

Álvarez-Aznar and colleagues which reported 90% increase in tdTomato-expressing 

microglia after tamoxifen treatment (Álvarez-Aznar et al., 2020). We observed direct contact 

between neuron and microglia. This could allow to analyze active interactions between 

microglia and neurons and determine if microglia selectively approached and phagocytosed 

synapses with different activity. Weinhard and colleagues used OHSC from the same mouse 

line to show that microglia engulf and trogocytose synaptic material (Weinhard et al., 2018). 

With emerging reasearch (Hong et al., 2016) highlighting the importance of microglia for 
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brain development and pathological conditions, it become increasingly important to visualize 

neurons and microglia in one setting. We believe, that experimental setting with visible 

neurons and microglia could provide new insights into role of microglia in activity-mediated 

synaptic pruning. 

We optimized conditions for AAV-hM4D expression and morphological assessment 

of axonal boutons and dendritic spines using AAV8/2-CaMKIIα::hM4Di(Gi)-mCherry-

WPRE-hgHp(A) DREADD construct. We defined that the application of AAV-hM4D could 

be performed no earlier than DIV5. This contradicted the findings of Avaliani and colleagues 

which showed DREADD-expressing neurons after DIV0 infection (Avaliani et al., 2016) but 

were similar to results of Cǎlin and colleagues which used infection at DIV3-5 (Cǎlin et al., 

2018). However, Avaliani used much higher virus load (2.49 x 1010 compared to our 9 x 108 

vg) and older animals for their OHSC (P6 – P8) (Avaliani et al., 2016). After that we 

established that OHSC had to be cultured for at least 11 days after infection for impactful 

activation of hM4D. These results were similar to Cǎlin and Zou both of which reported two-

week culturing period before activation (Cǎlin et al., 2018; Zou et al., 2016). Aiming for 

sparse but sufficiently bright labelling of neurons, we reduced the density of hM4D-mCherry-

expressing neurons and preserved the majority of the mCherry signal in already expressing 

neurons by reducing the virus load from 9 x 108 vg to 3.6 x 108 vg. However, mCherry signal 

was too weak for the visualization of axonal boutons and dendritic spines. We showed that 

further reduction of virus load to 1.8 x 108 vg and prolonging post-infection incubation up to 

18 days did not improve the density and the signal intensity of AAV-hM4D for the 

visualization of axonal boutons and dendritic spines. Delaying the infection up to DIV7 or 

DIV12 showed significant improvement for the labelling of dendrites and dendritic spines. 

Still, the mCherry signal was too weak for morphological analysis of dendritic spines. Other 

researchers (Avaliani et al., 2016; Cǎlin et al., 2018) who used comparable DREADD 

constructs obtained similar images of DREADD-expressing neurons without sufficient 

resolution to visualize axonal boutons or dendritic spines. These results might be caused by a 

physical link between artificial receptors and fluorescent reporter proteins or due to low 

activity of CaMKIIα promoter that regulates DREADD expression. 

Finally, we developed a strategy to inhibit neuronal activity and to visualize axonal 

boutons and dendritic spines using co-localization of EGFP and mCherry fluorescence in the 

same neuron. EGFP provided with robust signal and clearly labeled axonal boutons and 

dendritic spines suitable for morphological analysis (Fig. 3.4). Meanwhile mCherry signal 

could be used to identify neurons expressing hM4D-mCherry. Similar co-localization strategy 
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was used by Scofield and colleagues to check if astrocytes were expressing their DREADD of 

choice (rAAV5/GFAP-HA-hm3D-IRES-mCitrine) (Scofield et al., 2015). We believe this 

strategy would be suitable to acquire high detail images of axonal boutons and dendritic 

spines that had inhibited activity and to demonstrate whether the synapses with lower activity 

are preferentially removed during synaptic pruning. 
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CONCLUSIONS 

1. Organotypic hippocampal slice cultures proved to be a suitable setting for the visualization 

of maturing neurons during the period of synaptic pruning. 

2. Thy1::EGFP, RC::LSL-tdTomato, Cx3cr1::Cre mouse line is suitable for the visualization 

of direct contacts between neurons and microglia in OHSC. 

3. AAV8/2-CaMKIIα::hM4Di(Gi)-mCherry-WPRE-hgHp(A) DREADD can be successfully 

expressed in a subset of pyramidal neurons, but the resolution is not sufficient for the 

visualization of axonal boutons and dendritic spines. However, the morphology of 

inhibited neurons could be evaluated by analyzing EGFP-mCherry co-expressing neurons. 
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DEVELOPING TOOLS TO INVESTIGATE NEURONAL ACTIVITY IN 

SYNAPTIC PRUNING 

SUMMARY 

During development, synaptic pruning removes excess synapses and contributes to 

the formation of mature neuronal network. Synaptic pruning is performed by microglia that 

phagocytose synaptic material. It is essential to achieve optimal neural network and healthy 

nervous system. The impairments of synaptic pruning were linked to a variety of pathological 

conditions, including schizophrenia and autism spectrum disorders. Emerging data suggests 

that neuronal activity regulates synaptic pruning in competition-based mechanism. To 

investigate the role of neuronal activity in synaptic pruning we developed experimental 

approaches for the inhibition of neuronal activity and their visualization. First, we established 

organotypic hippocampal slice culture using Thy1::EGFP mice to provide robust labeling of 

excitatory pyramidal neurons of hippocampus in maturing brain tissue. Second, we used 

Thy1::EGFP, RC::LSL-tdTomato, Cx3cr1::Cre mice to visualize direct interactions between 

neurons and microglia. Third, we optimized conditions to use AAV8/2-

CaMKIIα::hM4Di(Gi)-mCherry-WPRE-hgHp(A) designer receptor exclusively activated by 

designer drugs (DREADD) to inhibit neuronal activity and visualize inhibited neurons. We 

determined that this DREADD construct is not suitable to perform morphological analysis of 

axonal boutons and dendritic spines but could be used with other neuron visualization tools. 

Finally, we proposed a strategy to analyze morphology of axonal boutons and dendritic spines 

of neurons inhibited during peak of synaptic pruning utilizing co-localization of EGFP and 

mCherry signals. 
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METODŲ, SKIRTŲ NEURONINIO AKTYVUMO ĮTAKAI SINAPSIŲ 

GENĖJIME TYRIMUI, TOBULINIMAS 

SANTRAUKA 

Nervų sistemos vystymosi metu sinapsių genėjimas atlieka svarbų vaidmenį šalinant 

perteklines sinapses bei formuojant brandų nervinį audinį. Šis procesas, kurį vykdo sinapses 

fagocituojančios mikroglijos ląstelės, yra būtinas optimaliam nervinio signalo perdavimui bei 

sveikos nervų sistemos susiformavimui, o genėjimo sutrikimai yra siejami su įvairiomis 

patologinėmis būklėmis, tokiomis kaip šizofreniją ar autizmo spektro sutrikimai. Naujausi 

duomenys rodo, jog sinapsių genėjimą reguliuoja neuroninis aktyvumas, todėl šiame darbe, 

siekdami tirti neuronų aktyvumo įtaką sinapsių genėjimui, mes tobulinome neuronų aktyvumo 

slopinimui bei nuslopintų neuronų vizualizacijai skirtus įrankius. Pirmiausia, naudodami 

genetiškai modifikuotas Thy1::EGFP peles, paruošėme organotipines hipokampo pjūvių 

kultūras, veikiančias kaip eksperimentinė aplinka besiformuojančiam nerviniam audiniui, 

kuriame galime stebėti neuronus. Vėliau mes panaudojome Thy1::EGFP, RC::LSL-tdTomato, 

Cx3cr1::Cre pelių liniją tiesioginės sąveikos tarp neuronų ir mikroglijos vizualizavimui. Taip 

pat optimizavome sąlygas AAV8/2-CaMKIIα::hM4Di(Gi)-mCherry-WPRE-hgHp(A) 

sintetinių receptorių specifiškai aktyvuojamų sintetinių ligandų (DREADD) konstrukto 

naudojimui slopinant neuronų aktyvumą bei vizualizuojant nuslopintus neuronus. Rezultatai 

parodė, jog šis DREADD konstruktas nėra tinkamas aksonų gumbelių bei dendritų spygliukų 

morfologinei analizei, tačiau galėtų būti naudojamas su kitais neuronų vizualizacijos įrankiais. 

Galiausiai šiame darbe pasiūlėme strategiją sinapsių genėjimo metu nuslopintų neuronų 

aksonų gumbelių bei dendritų spygliukų analizei panaudojant EGFP ir mCherry signalų 

kolokalizaciją. 
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SUPPLEMENTARY DATA 

 

 

Supplementary Figure 1. Designed ROI applied to rotated OHSC images. This ensures 

uniform selection of CA1b-CA3b regions. Slices after 11 days of culturing with 9 x 108 vg 

and 3.6 x 108 vg virus loads. Wide-field fluorescence imaging. 
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Supplementary Figure 2. The effect of Alexa568 antibody staining on background signal. 

Slices after culturing for DIV20 with 3,6 x 108 vg virus load infected at DIV5. Alexa 568 

staining was performed to amplify mCherry signal. Control sample received no treatment. 

Confocal fluorescence imaging. 
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Supplementary Figure 3. Change of hM4D-mCherry expression in ROIs that corresponded 

to CA1b-CA3b region at 11 (DIV16) and 15 (DIV20) days after DIV5 infection with 3,6 x 

108 vg. Wide-field fluorescence imaging. 
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